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Welcome to RMC-BestFit 
The U.S. Army Corps of Engineers (USACE) Risk Management Center (RMC), in collaboration with the Engineer 
Research and Development Center (ERDC) Coastal and Hydraulics Laboratory (CHL), developed the Bayesian 
estimation and fitting software (RMC-BestFit) to enhance and expedite flood hazard assessments within the Flood 
Risk Management, Planning, and Dam and Levee Safety communities of practice. 

RMC-BestFit is a menu-driven software package, which performs distribution fitting and Bayesian estimation from a 
choice of thirteen probability distributions. The software features a fully integrated modeling platform, including a 
modern graphical user interface, data entry capabilities, distribution fitting analysis, Bayesian estimation analysis, and 
report quality charts.  

Why you should use RMC-BestFit 
In Bayesian estimation, the values of the probability distribution parameters converge to a distribution rather than to a 
single best value. Quantification of the parameter uncertainty is particularly important in risk analysis because it allows 
you to assess the value of reducing the uncertainty. Typically, the parameter uncertainty can be reduced with more 
and better information through means of additional measurement, data collection and quality control, filling gaps in 
missing gage data, and record extension. With Bayesian analysis, we can also specify our prior knowledge on the 
parameters through expert elicitation, causal modelling, or regional analysis.  

The Bayesian approach is capable of incorporating all available sources of information into an analysis. For example, 
in a Bayesian flood frequency analysis, at-site gage data, paleoflood information, regional information, and causal 
rainfall-runoff results can be incorporated into the flood frequency curve, which can then be used to evaluate reservoir 
pool stage-frequency for use in Dam Safety risk assessments.  

The Bayesian estimation approach is flexible and coherent. Its assumptions are made explicit, and the analysis is 
repeatable and revisable. The ability of the Bayesian approach to use all pieces of information in conjunction is a 
major advantage over other traditional statistical methods, such as those that are recommended in Bulletin 17B (U.S. 
Geological Survey, 1982) and Bulletin 17C (U.S. Geological Survey, 2018). 

When should you use RMC-BestFit? Any time you perform a risk analysis that involves uncertainty, you can and 
should use RMC-BestFit. Typical applications in science and engineering include reliability analysis, and rainfall and 
flood frequency analysis.  

System Requirements 
The RMC-BestFit program and all dependent libraries were developed using the .NET Framework 4.6.1. As such, the 
program is currently only available for the Microsoft Windows operating system. The recommended system 
configuration for RMC-BestFit includes: 

• 64-bit Windows Operating System (Windows 7 or newer) 

• 512MB of RAM at a minimum 

• 2GB of free disk space at a minimum 

• Quad-Core CPU with 2.7GHz (or faster) clock speed 

• 1280x1024 screen resolution or higher (and at least a 17" monitor) 
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Installing RMC-BestFit 
RMC-BestFit version 1.0 is available as a portable package (.zip). Installing with a portable package does not require 
administrative rights. Simply extract all contents of the portable package to the desired computer location. After 
extraction, the package contents will look as shown in Figure 1. Simply double-click the executable RMC-BestFit.exe 
to get started. For easy access to the program, you can create a desktop shortcut and pin the program to your 
Windows taskbar.  

 
Figure 1 – Installing RMC-BestFit. 

Setting the File Association in Windows 
RMC-BestFit files have the “.bestfit” file extension. To have Windows automatically open .bestfit files with RMC-
BestFit, first right-click a .bestfit project file. Select Open with… from the resulting menu. 

 
Figure 2 – Right-Click Menu for Project File in Windows. 

 

Then, from the menu that appears when you select Open with..., click Try an app on this PC for an expanded list of 
already installed applications. If you do not see RMC-BestFit, scroll to the bottom and select Look for another app 
on this PC. This will open a Windows Explorer dialog. Navigate to and select the executable RMC-BestFit.exe, then 
click Open. When you’ve found RMC-BestFit and it has been selected, check the box labeled Always use this app 
to open [.bestfit] files before you click the OK button. Now .bestfit files will appear in Windows Explorer with the 
RMC-BestFit icon. You can now double-click a project file to automatically open it with RMC-BestFit. 

 
Figure 3 – RMC-BestFit Project with File Association in Windows. 
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Terms and Conditions for Use 
The United States Government, US Army Corps of Engineers, Risk Management Center ("RMC") grants to the user 
the rights to install RMC-BestFit "the Software" (either from a copy obtained from RMC, a distributor or another user 
or by downloading it from a network) and to use, copy and/or distribute copies of the Software to other users, subject 
to the following Terms and Conditions of Use: 

All copies of the Software received or reproduced by or for user pursuant to the authority of this Terms and Conditions 
of Use will be and remain the property of RMC. User may reproduce and distribute the Software provided that the 
recipient agrees to the Terms and Conditions for Use noted herein. 

RMC is solely responsible for the content of the Software. The Software may not be modified, abridged, decompiled, 
disassembled, unobfuscated or reverse engineered. The user is solely responsible for the content, interactions, and 
effects of any and all amendments, if present, whether they be extension modules, language resource bundles, 
scripts or any other amendment. 

The name "RMC-BestFit" must not be used to endorse or promote products derived from the Software. Products 
derived from the Software may not be called "RMC-BestFit" nor may any part of the "RMC-BestFit" name appear 
within the name of derived products. No part of this Terms and Conditions for Use may be modified, deleted or 
obliterated from the Software. No part of the Software may be exported or re-exported in contravention of U.S. export 
laws or regulations. 

Waiver of Warranty 
THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND 
EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE RMC-BESTFIT "AS IS," WITHOUT 
ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM ANY 
IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. Depending on state law, the foregoing disclaimer may not apply to you, and you may also have 
other legal rights that vary from state to state. 

Limitation of Liability 
IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, BE LIABLE FOR 
LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN 
CONNECTION WITH USE OF RMC-BESTFIT REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE. 

THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE LIABILITY OF ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, TO YOU OR ANY 
THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF 
RMC-BESTFIT WITH IDENTIFIED ERRORS CORRECTED. Depending on state law, the above limitation or 
exclusion may not apply to you. 

Indemnity 
As a voluntary user of RMC-BestFit you agree to indemnify and hold the United States Government, and its agencies, 
officials, representatives, and employees, including its contractors and suppliers, harmless from any claim or demand, 
including reasonable attorneys' fees, made by any third party due to or arising out of your use of RMC-BestFit or 
breach of this Agreement or your violation of any law or the rights of a third party. 

Assent 
By using this program you voluntarily accept these terms and conditions. If you do not agree to these terms and 
conditions, uninstall the program and return any program materials to RMC (If you downloaded the program and do 
not have disk media, please delete all copies, and cease using the program).  
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Graphical User Interface 
RMC-BestFit is a menu-driven software package that performs distribution fitting and Bayesian estimation from a 
choice of thirteen probability distributions. The software features a fully integrated modeling platform, including a 
modern graphical user interface, data entry capabilities, distribution fitting analysis, Bayesian estimation analysis, and 
report quality charts. 

The graphical user interface consists of a Menu Bar, Tool Bar, and four window panes. Starting from the left in 
Figure 4 and moving clockwise, the panes will be referred to as the Project Explorer, the Tabbed Documents, the 
Properties Window, and the Message Window. You may move, dock, hide, or close the window panes as desired. 

 
Figure 4 – RMC-BestFit User Interface. 
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Menu Bar 
The menu bar located at the top of main window, as shown in Figure 5, contains important commands needed for 
working with RMC-BestFit. For example, the Project menu contains commands related to the project you are working 
in. On the Tools menu, you can customize how RMC-BestFit behaves by selecting Options…, or restore the project 
from a backup file by selecting Restore from Backup.  

 
Figure 5 – RMC-BestFit Menu Strip. 

 

File 
The File menu provides essential file management functionality. From this menu, you may create a new project, open 
an existing project, save or save as, open recent projects, or exit the application.  

 
Figure 6 – File Menu. 

 

If this is the first time you're using RMC-BestFit, your recent projects list will be empty. Once you have exceeded the 
number of projects shown in the recent project list (the default is 10), a menu item labeled as More Files… will be 
available. After clicking this item, a Recent Files dialog will open showing all available recent project files (Figure 7). 
From here, you may open any recently used project file, or clear the recent project file list.  
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Figure 7 – Recent File Dialog. 

 

View 
You may move, dock, hide, or close the Project Explorer, Properties Window, and Message Window as desired. 
The View menu allows you to unhide or open these windows. In addition, you can restore the default layout of the 
window panes.  

 
Figure 8 – View Menu. 

 

Project 
The Project menu contains commands related to the project you are working in. From this menu, you can create a 
new input data, distribution fitting analysis, or Bayesian estimation analysis. In addition, you can edit the project 
properties. 

 
Figure 9 – Project Menu. 
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Tools 
The Tools menu provides important tools for managing your project file. On the Tools menu, you can customize how 
RMC-BestFit behaves by selecting Options…, or restore the project from a backup file by selecting Restore from 
Backup. See the Personalize RMC-BestFit section for more details. 

 
Figure 10 – Tools Menu. 

 

Window 
The Window menu allows you to close or activate the document windows. The active document will have a check 
mark next to it as shown in Figure 11. You can see all open windows by clicking Windows…, which will open a 
Windows dialog. From here, you can activate or save specific documents. In addition, you can select and close 
multiple documents at once.  

 
Figure 11 – Windows Menu. 

 

 
Figure 12 – Windows Dialog. 
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Help 
From the Help menu, you can access this Quick Start Guide, view the Terms & Conditions for Use, or view the 
About RMC-BestFit splash screen.  

 
Figure 13 – Help Menu. 

 

 
Figure 14 – About RMC-BestFit Splash Screen. 

Tool Bar 
The Tool Bar is located on the main window, below the Menu Bar. The buttons on the tool bar provide the most 
frequently used options under the File menu: 

• New Project 

• Open Project 

• Save Project 

 

 
Figure 15 – RMC-BestFit Tool Bar. 
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Window Layout 
In RMC-BestFit, you can customize the position, size, and behavior of windows to create window layouts that work 
best for you. When you customize the layout, RMC-BestFit will remember the configuration. For example, if you 
change the docking location of the Project Explorer and then close RMC-BestFit, the next time that you open the 
software, the Project Explorer will be docked in that same location.  

Types of Windows 
RMC-BestFit has two basic window types, tool windows and document windows. Tool windows include the Project 
Explorer, Properties Window, and Message Window. Document windows contain the project element files, such as 
input data, distribution fitting analyses, and Bayesian estimation analyses. The tool windows can be resized and 
dragged by their title bar, whereas the document windows can be dragged by their tab. On the tool windows title bar, 
there is a drop-down with other window options. Likewise, you can right-click on the document tab to set other options 
on the window. These options include docking, floating, and hiding windows.  

 
Figure 16 – Tools Window Options. 

 

 

 
Figure 17 – Document Window Options. 

  



 
RMC-BestFit Quick Start Guide 

 

 

  
11 

 

Tab Groups 
The windows can be grouped together to enhance your ability to manage a limited workspace while you are working 
with two or more open documents in RMC-BestFit. You can organize multiple document windows and tool windows 
into either vertical or horizontal tab groups, or move documents from one group to another. The windows and tab 
groups can also be floated and moved to different monitors. When you need to view or edit two documents at once, 
you can split windows by creating two horizontal tab groups as shown below in Figure 18. 

 
Figure 18 – Split Document Windows.  

Arrange and Dock Windows 
A document window can be docked, so that it will be located in the Tabbed Documents area, or the document can 
be floated as a separate window independent of the main window. You can arrange windows in the following ways: 

• Dock tool windows to the edge of the main window frame.  

• Float tool and document windows over or outside the main window.  

• Hide tool windows along the edge of the main window.  

• Display windows on different monitors. 

• Reset window placement to the default layout by choosing View > Reset Default Layout.  

 
Arrange windows by dragging or right-clicking the title bar or tab of the window to be arranged.  
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Dock Windows 
When you click and drag the title bar of a tool window, or the tab of a document window, a cross shaped window 
placement guide will appear. During the drag operation, when the mouse cursor is over one of the arrows in the guide, 
a shaded area will appear that shows you where the window will be docked if you release the mouse button. An 
example of the window placement guide is shown below in Figure 19 and Figure 20. 

 
Figure 19 – Moving and Docking Document Windows.  

 

Figure 20 shows the Properties Windows being docked below the Project Explorer. The new location is 
demarcated by the light blue shared area. 

 
Figure 20 – Example of Docking the Properties Window Below the Project Explorer.  
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Close and Auto-Hide Tool Windows 
You can close a tool window by clicking on the X in the upper right of the title bar. To reopen the tool window, 
navigate to the View menu and select the desired tool window to show. Tool windows have an auto-hide feature, 
which causes a window to slide out of the way when you use a different window. When a window is auto-hidden, the 
window name appears on the tab at the edge of the main window as shown in Figure 21. To show the window again, 
move your mouse cursor over the tab so that the window slides back into view.  

 
Figure 21 – Auto-Hide Tool Window.  

 

  



 
RMC-BestFit Quick Start Guide 

 

 

  
14 

 

Project Explorer 
The Project Explorer, which is typically on the left-hand side of the main window, shows a graphical representation of 
the hierarchy of elements within your project. After you create a new project, you can use the Project Explorer to 
view, navigate, and manage the project elements.  

 
Figure 22 – Project Explorer. 

 

Project elements are organized under the Input Data, Distribution Fitting Analysis, and Bayesian Estimation 
Analysis folder headers. Many menu commands are available from the right-click menu on various items in the 
Project Explorer. You can create new elements, or sort the element collections, by right-clicking the header. 

 
Figure 23 – Project Explorer Element Collection Header Right-Click Menu. 
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When right-clicking an individual project element, the following commands are made available: edit, copy, rename, 
delete, move up, and move down. When multiple project elements are selected, only two right-click menu commands 
are available: edit and delete. Double-clicking a project element will open it for editing. 

 
Figure 24 – Project Explorer Element Right-Click Menu. 

 

You can move individual project elements within a collection by left-clicking and dragging the element. A mouse 
cursor adornment will appear indicating where the element will be moved, as shown in Figure 25. You can also drag 
and drop Input Data from one RMC-BestFit project to another. 

 
Figure 25 – Project Explorer Element Drag and Drop. 
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Tabbed Documents 
In RMC-BestFit, document windows contain the project element files, such as input data, distribution fitting analyses, 
and Bayesian estimation analyses. When you open a project element for editing, it will automatically open into the 
tabbed document group, which is typically located in the center of the main window (see Figure 26). You can reorder 
the tabbed documents, drag, or float them outside of the main window. When you click on, or activate, a document 
window, the associated project element properties will be shown in the Properties Window.  

 
Figure 26 – Tabbed Document Group. 
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Properties Window 
The Properties Window, which is typically on the right-hand side of the main window, displays the properties for the 
project and project elements. To access the element properties, first open the element for edit, then click on, or 
activate, the associated tabbed document. Some properties are common among all project elements, such as Name 
and Description, while others are unique to the specific elements. Properties are organized into groups for easier 
navigation. When you click on a property, the property description will be placed at the bottom of the properties 
window as shown in Figure 27. All analyses will be run from the properties window.  

 
Figure 27 – Properties Window. 
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Message Window 
The Message Window shows you errors, warnings, messages and event logs regarding the current state of your 
project. If there are any errors in your project file, they are listed here. The Message Window lets you perform the 
following tasks: 

• Display the errors, warnings, messages, and events produced while you work in RMC-BestFit.  

• Double-click any error message entry to open the project element where the problem occurs.  

• Filter the type of entries that are displayed in the Message Window. The default is to only display errors and 
warnings. 

• Export all entries to a text file.  

 
Once you resolve an error, warning, or message, the entry will be removed from the Message Window. You may 
customize the font color of the various message types by navigating to Tools > Options. See the Personalize RMC-
BestFit section for more details. 

 
Figure 28 – Message Window. 

 

 

  



 
RMC-BestFit Quick Start Guide 

 

 

  
19 

 

Personalize RMC-BestFit 
You can personalize RMC-BestFit in various ways to enhance the user experience by navigating to Tools > Options. 
The Options dialog allows the user to customize the Application, File Management, Message Window, and Default 
settings.  

Application Options 
You can set the application color theme to be the Light theme or Blue theme as shown in Figure 29 and Figure 30. 
The default is set to the Light theme. You can choose whether or not to Save the window docking layout on close 
so that RMC-BestFit will remember it when you reopen the application. You can also set the number of window items 
shown in the Window menu and the number of recent project items shown in the Recent Project list under the File 
menu.  

 
Figure 29 – Options Dialog with Light Color Theme.  

 

 
Figure 30 – Options Dialog with Blue Color Theme.  
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File Management Options 
RMC-BestFit project files are saved as SQLite databases. SQLite is a self-contained, high-reliability, SQL database 
engine, which is also the most used database engine in the world (https://www.sqlite.org/). Database files can grow 
quickly as you use them, sometimes hindering performance. They can also occasionally become corrupt or damaged. 
You can use the Tools > Compact & Optimize Project File command to prevent or fix these problems. You can also 
set RMC-BestFit to Compact & optimize project file on close.  

You can set the time interval in which a project backup file is created. A file with the extension .bak is automatically 
created when a project is opened. If the project closes successfully, then the .bak file is deleted. The database file can 
be damaged or corrupted, or the system could close unexpectedly causing you to lose important data, so on 
occasion, you might need to restore the project from a backup file by selecting Tools > Restore from Backup.  

 
Figure 31 – File Management Options.  
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Message Window Options 
You can adjust the auditory and visual setting for the Message Window. You can choose to turn on or off the beep 
sound effect and select the font color for the different message types, as shown below in Figure 32. 

 
Figure 32 – Message Window Options.  

 

Default Options 
You can set the default project location directory, and the default decimal digits for the project inputs and outputs.  

 
Figure 33 – Default Options.  
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Plot Features 
RMC-BestFit has plot features which allow you to examine the plot data and customize the plots for reporting 
purposes. There is a tool bar located to the right of each plot, which allows you to interact with the plot in the following 
ways:  

• Track data to get the X-Y point values.  

• Pan the plot up and down or side to side.  

• Zoom in to the plot data. 

• Zoom out to the plot extents. 

• Add annotations to the plot. 

• Save the plot image as a PNG, PDF, or SVG file.  

• Export plot series data to a Comma Separate (.csv), Excel (.xlsx), or SQLite (.sqlite) file. 

• Change the plot properties to create a customized appearance. The changes to the plot properties are saved 
and persist when you open and close the project and project element.  

 

 
Figure 34 – RMC-RFA Plot Features.  
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Track Data  
The Track Data mouse pointer disables all other plot features when selected. Click on any plotted point or line in the 
graph to show a tooltip displaying the plot series name and X and Y data points.  

 
Figure 35 – Track Data on Plot.  

 

Pan 
The Pan feature allows you to navigate through the plot by clicking and dragging on the graph. The plot can be 
panned in any direction, up, down, and side to side.  

Zoom 
You can Zoom In on the plot to view data more precisely at smaller intervals. Zooming works by highlighting the area 
of interest with the magnifying glass cursor (see Figure 36), or by zooming in and out using the mouse wheel. When 
you zoom in on the plot you may also Pan the plot area. To zoom all the way back out, click the Zoom to Extents 
button on the plot tool bar.  
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Figure 36 – Zoom In on Plot. 

 

Add Annotation 
Annotations are elements of the plot that show information that is not part of a plot series. Annotations are not 
included in the legend and not used by the tracker. You may add the following annotation types to the plot: 

• Arrow  

• Text 

• Vertical Line 

• Horizontal Line 

• Rectangle 

• Ellipse 

• Point 

• Polygon 

• Polyline 

 
The annotations can be moved by clicking and dragging them to a new spot. An example of adding an arrow 
annotation is shown in Figure 37 and Figure 38. 
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Figure 37 – Plot Annotations. 

 

 
Figure 38 – Example of Arrow Annotation. 
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Export Series Data 
The plot series data can be exported to a Comma Separated (.csv), Excel (.xlsx), or SQLite (.sqlite) file. After clicking 
the Export Series Data button, a Save As dialog will open. Select the desired file type and give the file a name, then 
click save. If the data is exported to a Comma Separated file, each plot series will be stored in separate columns. 
Whereas, if the data is exported to Excel, the series data will be stored on separate worksheet tabs. Likewise, if the 
data is exported to SQLite, the series data will be stored in separate tables.  

 
Figure 39 – Save As Dialog for Exporting Series Data. 
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Save Plot Image 
The plot image can be saved as a PNG, PDF, or SVG file. Before saving, you can set the width and height of the 
image. After the Save As dialog opens, give the plot image a name and click save.   

 
Figure 40 – Set the Width and Height of the Plot Image. 

 

 
Figure 41 – Save Plot Dialog. 

 

 

 

 

 

 

 



 
RMC-BestFit Quick Start Guide 

 

 

  
28 

 

Plot Properties 
You can edit the Plot Properties by clicking the gear wheel button in the plot tool bar. The plot properties will open in 
the Properties Window. From here, you can edit the general plot settings, legend, axes, series, and annotations. The 
plot properties will open to the General Plot Settings by default. Click the chevron in the upper right to open a drop 
down showing the other plot elements to edit.  

 
Figure 42 – Plot Properties. 
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Working with RMC-BestFit 
In this quick start guide, we will demonstrate how to create a project, enter input data, select a model using the 
distribution fitting analysis, and perform a Bayesian estimation analysis.  

Create a Project 
To begin, let’s create a new project. When you open RMC-BestFit, a Blank Project file is automatically created, as 
shown in Figure 43. The blank project is stored in your local temp directory. You may begin working with the blank 
project file immediately. 

 
Figure 43 – RMC-BestFit Blank Project. 

 

To save changes to the blank project, click the Save button on the tool bar or under the File menu. This will open the 
Save Project As… prompt. Enter the desired file name and click the save button in the bottom right. Now you are 
ready to continue working with RMC-BestFit. 

 
Figure 44 – Save Project As…. 
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A new project can also be created by clicking New Project… under the File menu, or by clicking the New Project 
button located on the tool bar as shown in Figure 45 and Figure 46. If this is the first time you're using RMC-BestFit, 
your recent projects list will be empty.  

 
Figure 45 – Create New Project from the File Menu. 

 

 
Figure 46 – Create New Project from the Tool Bar. 

 

The project properties will be shown in the Properties Window, which is typically located on the right-hand side of the 
main window. You may edit the project name and description.  

 

Figure 47 – Project Properties. 
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Input Data 
In RMC-BestFit, the input data must be entered as block annual maxima, which are assumed to be independent and 
identically distributed (iid). RMC-BestFit supports three different data types: 

1. Systematic Data: Data that are collected at regular, prescribed intervals under a defined protocol. In a 
maximum likelihood context, these values are treated as exact measurements. Low outlier tests can be 
performed on the systematic data to ensure homogeneity. 
 

2. Interval Data: Data whose magnitudes are not known exactly, but are known to fall within a range or interval. 
In a maximum likelihood context, these values are treated as interval-censored. 
 

3. Perception Thresholds: Data points that occurred during a period of years and have magnitudes that are 
below a threshold value, but unknown by how much. In a maximum likelihood context, these values are 
treated as left-censored. 

The Distribution Fitting Analysis chapter provides greater detail on how these data types are treated in a likelihood 
context.  

Create New Input Data 
Let’s begin by creating a new input dataset. Right-click on the Input Data folder header and click Create New… as 
shown in Figure 48. Next, give the Input Data a name and click OK. 

 
Figure 48 – Create New Input Data. 

 

Once the new Input Data is created, it will be automatically opened into the Tabbed Documents area, and the input 
data properties will be displayed in the Properties Window. From here, you can set the Description, Unit Label, 
Plotting Position Parameter, and perform a Low Outlier Test.  

For this example, we will be using 3-day inflow volumes for Blakely Mountain Dam, which is located near Hot Springs, 
Arkansas. This dataset includes systematic data, historical data dating back to 1870, and paleoflood information 
dating back 5,000 years. As shown in Figure 49, set the Unit Label to be “3-Day Flow (CFS)” and you will notice that 
this automatically updates the Y-axis labels on the Chronology and Frequency plots.  
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Figure 49 – Input Data Properties. 

 

Systematic Data 
Systematic data are collected at regular, prescribed intervals under a defined protocol. In a maximum likelihood 
context, these values are treated as exact measurements. The systematic dataset for Blakely Mountain Dam is 
provided in Table 1. Note that the systematic data does not need to be continuous; e.g., the Blakely Mountain dataset 
has missing data from 1931 to 1935. Gaps in data can be accounted for using thresholds, which will be demonstrated 
later in the Perception Thresholds section. 

To enter data, first click the Add Row(s) button located on the left side of the table tool bar. This will add a blank row 
to the bottom of the table. Next, you can either manually enter your dataset, or copy and paste the dataset into the 
table as shown in Figure 51. Once you have entered all of the data, you will see that the plotting positions are 
automatically calculated and the data is plotted in the Chronology and Frequency plot as illustrated in Figure 52. 

 
Figure 50 – Add Systematic Data. 
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Table 1 – Systematic Dataset of 3-Day Inflows at Blakely Mountain Dam near Hot Springs, Arkansas. 

Year Flow 
(CFS) Year Flow 

(CFS) Year Flow 
(CFS) 

1923 57,985 1959 17,032 1990 30,122 
1924 14,607 1960 45,014 1991 32,586 
1925 8,403 1961 12,637 1992 34,357 
1926 23,479 1962 17,037 1993 32,586 
1927 66,629 1963 9,074 1994 45,065 
1928 30,925 1964 36,066 1995 29,547 
1929 25,046 1965 15,261 1996 14,310 
1930 37,772 1966 23,886 1997 44,107 
1936 9,074 1967 22,432 1998 15,676 
1937 21,382 1968 55,536 1999 18,922 
1938 43,769 1969 43,938 2000 17,981 
1939 50,678 1970 22,490 2001 40,097 
1940 7,360 1971 26,955 2002 42,471 
1941 15,617 1972 53,417 2003 17,451 
1942 23,189 1973 36,920 2004 14,964 
1943 12,637 1974 42,584 2005 20,798 
1944 30,064 1975 39,587 2006 19,157 
1945 52,914 1976 12,996 2007 33,729 
1946 22,607 1977 30,294 2008 58,319 
1947 14,191 1978 8,952 2009 35,041 
1948 19,098 1979 28,109 2010 32,700 
1949 35,383 1980 12,637 2011 35,212 
1950 25,046 1981 15,142 2012 34,585 
1951 13,355 1982 16,624 2013 46,921 
1952 20,330 1983 81,464 2014 15,795 
1953 25,701 1984 13,952 2015 42,189 
1954 26,897 1985 40,946 2016 55,982 
1955 20,019 1986 29,317 2017 34,585 
1956 18,240 1987 24,930 2018 48,324 
1957 21,084 1988 42,076   
1958 28,886 1989 26,551   

 

 
Figure 51 – Paste Data into Table. 
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Figure 52 – Systematic Data. 

 

You can view the data as a chronology plot or as a frequency plot by toggling the radio buttons located underneath 
the plot as shown in Figure 53. Clicking the Chronology Plot radio button will display the data in chronological order, 
with the years on the X-axis. The Frequency Plot radio button will display the data as a nonparametric frequency plot 
based on the Hirsch-Stedinger plotting positions.  

 
Figure 53 – View Chronology or Frequency Plot. 
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Data Table Features 
You can edit the data table by using the tool bar located above the table, or by right-clicking within the table. You can 
interact with the table in the following ways: 

• Add rows(s) to the bottom of the table. 

• Insert row(s) into the table.   

• Delete row(s) from the table. 

• Select all table cells. 

• Copy the selected cells. 

• Copy the selected cells with the table headers. 

• Paste from the clipboard into the table. 

• Sort a column in ascending or descending order. 

• Clear all table sorting.  

 
You can sort a column by right-clicking on the column header as shown below.  
 

 
Figure 54 – Sort Input Data Tables. 

 

Data Validation 
The input data tables have built-in validation. The Systematic Data have the following requirements: 

• The year must be unique. 

• The year must be between -100,000 and +100,000. 

• The value must be non-negative, or greater than or equal to zero. 

 
When you enter invalid data, the table cell will turn red, and provide a tooltip indicating the source of the error. In 
addition, an error message will appear in the Message Window indicating that you must resolve all errors in the data 
table.  
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Figure 55 – Input Data Validation. 

 

Plotting Positions 
The input data can be plotted as a Chronology Plot or as a nonparametric Frequency Plot as shown in Figure 53. A 
frequency plot or probability plot is a plot of magnitude versus a probability. The probability assigned to each data 
point is commonly determined using a plotting position formula. Plotting positions are a method for creating an 
empirical frequency. The formula computes the exceedance probability of a data point based on the rank of the data 
point in a sample of a given size. The plotting positions typically have significant uncertainty due to sampling error 
resulting from small sample sizes.  

A rank-order method is used to plot the annual maxima data. This involves ordering the data from the largest event to 
the smallest event, assigning a rank of 1 to the largest event and a rank of n to the smallest event, and using the rank 
(i) of the event to obtain a probability plotting position. Many plotting position formulae are special cases of the general 
formula: 

𝑃𝑃𝑖𝑖 =
𝑖𝑖 −  𝛼𝛼

𝑛𝑛 + 1 − 2𝛼𝛼
 Equation 1 

where i is the rank of the event, 𝑛𝑛 is the sample size, 𝛼𝛼 is a constant greater than or equal to 0 and less than 1, and Pi 

is the exceedance probability for an event with rank i. The value of 𝛼𝛼 determines how well the calculated plotting 
positions will fit a given theoretical probability distribution.  

RMC-BestFit uses the Hirsch-Stedinger (H-S) plotting position formula (Hirsch & Stedinger, 1987) (U.S. Geological 
Survey, 2018), which is an extension of the general formula above that is also capable of incorporating threshold-
censored data. The H-S plotting positions are used to visually and quantitatively assess the goodness-of-fit of the 
fitted distributions (see the Goodness-of-Fit Measures section for more detail).   

You can choose from the following 𝛼𝛼 parameter options: 

• Weibull (𝛼𝛼 = 0.0): Recommended as the default value because it is unbiased for all distributions. 

• Median (𝛼𝛼 = 0.3175): Provides median exceedance probabilities for all distributions. 

• Blom (𝛼𝛼 = 0.375): Recommended for Normal, Gamma, 2-parameter Log-Normal, 3-parameter Log-Normal, 
and Log-Pearson Type III distributions. 

• Cunnane (𝛼𝛼 = 0.40): Recommended for Generalized Extreme Value and Log-Gumbel distributions, 
approximately quantile unbiased. 

• Gringorten (𝛼𝛼 = 0.44): Recommended for Exponential, Gumbel and Weibull distributions. 

• Hazen (𝛼𝛼 = 0.50): Recommended when the parameters of the parent distribution are unknown. 

As you can see, each plotting position parameter has a different motivation. Some attempt to achieve unbiasedness in 
quantile estimates across multiple distributions, while other formulas are optimized for use with a particular theoretical 
probability distribution. Choosing a plotting position parameter is similar to choosing a probability distribution to 
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represent a particular set of data. It is often better to select a plotting position parameter that is flexible and makes the 
fewest assumptions. For this reason, the Weibull parameter (𝛼𝛼 = 0.0) is set as the default value in RMC-BestFit, 
which is consistent with current practice. 

When you hover over the plotting position drop-down, you will see a tooltip providing the recommended use for the 
given parameter as shown below.  

 
Figure 56 – Set Plotting Position Parameter. 

 

Low Outlier Test 
For the distribution fitting or Bayesian estimation analyses to be theoretically valid, the input data must be 
independent and identically distributed. As a means to ensure homogeneity, RMC-BestFit provides the Multiple 
Grubbs-Beck test (MGBT) (Cohn, et al., 2013) for low outliers, which is consistent with the Bulletin 17C guidelines 
(U.S. Geological Survey, 2018). In RMC-BestFit, the MGBT is only applied to systematic data, which are considered 
exact measurements. Interval- and threshold-censored data are not included in the test. 

To run the MGBT, make sure the Multiple Grubbs-Beck Test checkbox is checked, and click the Run Test 
command button. When the test is complete, a message box will appear that reports how many low outliers were 
identified. In addition, the MGBT Critical Value will be displayed in the Threshold Value textbox. There should be 
zero low outliers identified for this dataset, so the threshold value should also be set to zero as shown in Figure 57. 
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Figure 57 – Run Multiple Grubbs-Beck Low Outlier Test. 

 

If desired, you also have the option to enter a value for the low outlier threshold. When you run the test, any data 
value below this threshold will be identified as a low outlier. The Threshold Value cannot be set to a value that would 
censor more than 50 percent of the values within the data set. To use this option, uncheck the Multiple Grubbs-Beck 
Test checkbox and enter the preferred value. 

Values that are identified as low outliers will be checked in the Is Low Outlier column of the systematic data table. The 
low outliers will be displayed as a red X in the chronology and frequency plots.  

The low outlier threshold value identified by the MGBT or manual threshold value is automatically treated as a left-
censored threshold in the distribution fitting and Bayesian estimation analyses. For example, if the low outlier 
threshold value is 8,000 and there are eight data points below the threshold identified as low outliers, then this is 
treated equivalent to a left-censored threshold with eight values below and zero above. However, RMC-BestFit does 
not include the low outlier threshold in the H-S plotting position routine. Conceptually, the low outlier test removes 
exact data points and replaces them with a threshold-censored value. This represents a loss in information. However, 
if this low outlier threshold is included in the H-S routine, then it will make the plotting positions rarer, signaling an 
increase in information. This is counterintuitive, and for this reason RMC-BestFit does not include the low outlier 
threshold in the H-S plotting position routine. 
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Interval data 
Interval data have magnitudes that are not known exactly, but are known to fall within a range or interval. A paleoflood 
study was performed for the Blakely Mountain watershed, where two major historical floods were identified: one 
occurred in 1882 and another occurred sometime around the year 1020.  

Table 2 – Interval Data for 3-Day Inflows at Blakely Mountain Dam near Hot Springs, Arkansas. 

Year Lower Most Likely Upper 
1020 105,000 110,000 115,000 
1882 66,000 76,000 86,000 

 

You can add the interval data in the same manner as was done for the systematic data. First click the Add Row(s) 
button located on the left side of the table tool bar. This will add a blank row to the bottom of the interval data table. 
Next, you can either manually enter the data, or copy and paste the interval data into the table. Once you have 
entered the data, you will see that the plotting positions are automatically calculated and the intervals are plotted in 
the Chronology and Frequency plot as vertical bars (see Figure 58). 

 
Figure 58 – Interval Data. 

 

The Interval Data have the following requirements: 

• The year must be unique. 

• The year must be between -100,000 and +100,000. 

• The year cannot overlap with any data point in the Systematic Data table.  

• The lower, most likely, and upper values must be non-negative, or greater than or equal to zero. 

• The lower must be less than the most likely value, and the upper must be greater than the most likely value. 
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Perception Thresholds 
The term perception threshold originates from Bulletin 17C (U.S. Geological Survey, 2018). For the purposes of RMC-
BestFit, a Perception Threshold defines a threshold level over a period of years. Data points that occurred during 
the threshold period have magnitudes that are below the threshold value, but it is unknown by how much. Conversely, 
we can also say that if an event occurred during the threshold period, and it had a magnitude larger than the threshold 
value, then we would have evidence it occurred; i.e., data points larger than the threshold would have been perceived 
by us.  

There were four perception thresholds identified for the Blakely Mountain Dam 3-day inflow volume dataset (see 
Table 3). The paleoflood study determined that 3-day inflows have not exceeded 220,000 cfs in the last ~5,000 years. 
Flood volumes did not exceed 104,000 cfs during the years between the paleoflood in 1019 and 1869. From 1870 to 
the 1922, which is the beginning of the systematic dataset, 3-day flood volumes did not exceed 65,000 cfs, except for 
the large 1882 event. Finally, 3-day flood volumes during the missing years of systematic data from 1931 to 1935, 
also did not exceed 65,000 cfs.  

Table 3 – Threshold Data for 3-Day Inflows at Blakely Mountain Dam near Hot Springs, Arkansas. 

Start Year End Year Value 
-2980 1018 220,000 
1019 1869 104,000 
1870 1922 65,000 
1931 1935 65,000 

 

Threshold data is entered in the same manner as was done for the systematic and interval data. Click the Add 
Row(s) button located on the left side of the table tool bar. Next, you can either manually enter the data, or copy and 
paste the threshold data into the table. Once you have entered the data, you will see that the plotting positions are 
automatically calculated and the thresholds are plotted in the Chronology plot as a shaded area (see Figure 59). 

 
Figure 59 – Perception Thresholds. 
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The Perception Threshold Data have the following requirements: 

• The start and end years must be between -100,000 and +100,000. 

• The start year must be less than or equal to the end year. 

• The start and end years of the thresholds must be entered in ascending order.  

• The threshold periods cannot overlap with each other.  

• The threshold values must be non-negative, or greater than or equal to zero. 

Summary Statistics 
RMC-BestFit provides summary statistics for the systematic data and for all of the data, including low outliers, 
intervals, and perception thresholds (see Figure 60). Summary statistics for the systematic data are based on the 
sample moments and percentile estimates, while summary statistics for all data are based on the nonparametric H-S 
plotting positions. The central moments of the nonparametric distribution are estimated using numerical integration. 
The nonparametric distribution functions are provided in Equation 2 to Equation 4. Percentiles are estimated using the 
inverse cumulative distribution function as shown in Equation 4.  

𝑓𝑓(𝑥𝑥) =  
𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖

𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖
, Equation 2 

where 𝑓𝑓(𝑥𝑥) is the probability density function (PDF) of the variable 𝑋𝑋; there is an array of continuous values {𝑥𝑥} =
{𝑥𝑥1, 𝑥𝑥2, … , 𝑥𝑥𝑛𝑛} for 𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 < 𝑥𝑥𝑖𝑖+1with non-exceedance probabilities {𝑝𝑝} = {𝑝𝑝1, 𝑝𝑝2, … , 𝑝𝑝𝑛𝑛} with 0 ≤ 𝑝𝑝𝑖𝑖 ≤ 1.  

𝐹𝐹(𝑥𝑥) = 𝑝𝑝𝑖𝑖 + (𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖) �
𝑥𝑥 − 𝑥𝑥𝑖𝑖

𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖
� Equation 3 

𝐹𝐹−1(𝑝𝑝) = 𝑥𝑥𝑖𝑖 + (𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖) �
𝑝𝑝 − 𝑝𝑝𝑖𝑖

𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖
� Equation 4 

where 𝐹𝐹(𝑥𝑥) is the cumulative distribution function (CDF) of the variable 𝑋𝑋; 𝐹𝐹−1(𝑝𝑝) is the inverse CDF; and there is an 
array of continuous values {𝑥𝑥} = {𝑥𝑥1, 𝑥𝑥2, … , 𝑥𝑥𝑛𝑛} for 𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 ≤ 𝑥𝑥𝑖𝑖+1with non-exceedance probabilities {𝑝𝑝} = {𝑝𝑝1, 𝑝𝑝2, … , 𝑝𝑝𝑛𝑛} 
with 0 ≤ 𝑝𝑝𝑖𝑖 ≤ 1 and 𝑝𝑝𝑖𝑖 ≤ 𝑝𝑝 ≤ 𝑝𝑝𝑖𝑖+1.  

The summary statistics provide a preview for what to expect when performing distribution fitting or Bayesian 
estimation. For example, in the case of Blakely Mountain Dam, we can see that the inclusion of historical and 
paleoflood data slightly increased the skewness of the data. The systematic data has a skewness (of log) of -0.2388; 
whereas the nonparametric analysis, which includes all of the data, has a skewness (of log) of -0.2151. We should 
expect to see a similar behavior when fitting the Log-Pearson Type III distribution. 
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Figure 60 – Input Data Summary Statistics.  
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Distribution Fitting Analysis 
The Distribution Fitting Analysis in RMC-BestFit uses the method of Maximum Likelihood Estimation (MLE) to fit 
several univariate probability distributions to the user-specified Input Data. You can use the distribution fitting analysis 
results to inform model selection for use in the Bayesian estimation analysis. For each fitted distribution, RMC-BestFit 
provides three goodness-of-fit measures: the Akaike Information Criteria (AIC), the Bayesian Information Criteria 
(BIC), and Root-Mean Squared Error (RMSE). These measures indicate how well the distribution fits the input data, 
with a smaller value representing a better fit. 

To fit distribution with RMC-BestFit, there are four steps required: 

• Define Input Data. 

• Run the fitting analysis.   

• Interpret the results. 

• Select a distribution to use in the Bayesian Estimation Analysis. 

Further details of these steps are discussed in the following sections.  

Create New Distribution Fitting Analysis 
Let’s create a new Distribution Fitting Analysis. Right-click on the Distribution Fitting Analysis folder header and 
click Create New… as shown in Figure 61. Next, give the fitting analysis a name and click OK. 

 
Figure 61 – Create New Distribution Fitting Analysis. 

 

Once, the new Distribution Fitting Analysis is created, it will be automatically opened into the Tabbed Documents 
area, and the fitting analysis properties will be displayed in the Properties Window. From here, you can set the 
Description, Input Data, Output Frequency Ordinates, and Fit Distributions.  

Define Input Data 
Click the Input Data drop-down and select the desired data for the fitting analysis as shown in Figure 62. You can set 
the Output Frequency Ordinates by clicking on the Options tab at the top of the Properties Window as shown in 
Figure 63. The output frequency ordinates are the annual exceedance probabilities (AEP) used for plotting the fitted 
distributions on the frequency plot. The default frequency ordinates range from 0.99 to 1E-6 AEP.  

 



 
RMC-BestFit Quick Start Guide 

 

 

  
44 

 

 
Figure 62 – Distribution Fitting Analysis Properties. 

 

 

 
Figure 63 – Distribution Fitting Analysis Output Frequency Ordinates. 
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Run the Fitting Analysis 
After you have selected the Input Data, click the Fit Distributions command button to run the distribution fitting 
analysis. The runtime typically takes less than a second. When the analysis is complete, you will see a table of 
goodness-of-fit measures and all of the distributions plotted on the Frequency Plot as shown in Figure 65. 

 
Figure 64 – Run the Distribution Fitting Analysis. 

 

 
Figure 65 – Distribution Fitting Analysis Graphical Results. 
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Maximum Likelihood Estimation (MLE) 
In the distribution fitting analysis, parameters are estimated using the MLE method. The MLE method formulates a 
likelihood function using sample data 𝐷𝐷 = (𝑋𝑋1, … , 𝑋𝑋𝑛𝑛) and the parameters 𝜃𝜃 of the probability distribution, and solves 
for the value of the parameters that maximize the likelihood function (Rao & Hamed, 2000) (Jongejan, 2018). The 
likelihood function gives the probability of the data conditional on the distribution parameters (Equation 5). 

𝐿𝐿𝑆𝑆(𝐷𝐷|θ) =  � 𝑓𝑓(𝑋𝑋𝑖𝑖|θ)
𝑛𝑛𝑠𝑠

𝑖𝑖=1

 Equation 5 

where 𝐷𝐷 is the sample of systematically recorded annual discharge maxima (𝑋𝑋1, … , 𝑋𝑋𝑛𝑛𝑆𝑆); and 𝑓𝑓(∙) is the probability 
density function (PDF) of the variable 𝑋𝑋. Censored data can be incorporated into the MLE method by augmenting the 
likelihood function. Left-censored threshold data has the following likelihood function: 

𝐿𝐿𝐿𝐿(𝐷𝐷|θ) =  � �
ℎ
𝑘𝑘

� 𝐹𝐹(𝑋𝑋0|θ)(ℎ−𝑘𝑘)

𝑛𝑛𝐿𝐿

𝑖𝑖=1

 Equation 6 

where 𝑋𝑋0 is the threshold; ℎ is the threshold period; 𝑘𝑘 is the number of observations that exceeded the threshold during 
the period; �ℎ

𝑘𝑘� is the binomial coefficient; and 𝐹𝐹(∙) is the cumulative distribution function (CDF) of the variable 𝑋𝑋0. The 
binomial coefficient can be dropped from Equation 6 because it will be held constant as 𝜃𝜃 is varied. Interval-censored 
data has the following likelihood function: 

𝐿𝐿𝐼𝐼(𝐷𝐷|θ) = ��𝐹𝐹�𝑋𝑋𝑈𝑈𝑖𝑖�𝜃𝜃� − 𝐹𝐹�𝑋𝑋𝐿𝐿𝑖𝑖�𝜃𝜃��
𝑛𝑛𝐼𝐼

𝑖𝑖=1

 Equation 7 

where there are  𝑛𝑛𝐼𝐼 observations known to lie between upper and lower bounds, 𝑋𝑋𝑈𝑈 and 𝑋𝑋𝐿𝐿. The overall likelihood 
function is then constructed by multiplying the components: 

𝐿𝐿(𝐷𝐷|θ) =  𝐿𝐿𝑆𝑆(𝐷𝐷|θ) ∙  𝐿𝐿𝐿𝐿(𝐷𝐷|θ) ∙  𝐿𝐿𝐼𝐼(𝐷𝐷|θ) Equation 8 

These likelihood formulations for censored data are consistent with those presented in (Stedinger & Cohn, 1986), 
(Kuczera G. , 1999), and (O'Connell, Ostenaa, Levish, & Klinger, 2002).  

From the perspective of Bayesian estimation, MLE is a special case of maximum a posteriori (MAP) that assumes a 
uniform prior distribution for each model parameter. Therefore, if we assume uniform priors in the Bayesian 
Estimation Analysis, we will get the same posterior mode as the MLE method used in the Distribution Fitting 
Analysis (any differences in results would be attributed to convergence errors).   

RMC-BestFit uses the Nelder-Mead method (also commonly called the downhill simplex method or amoeba method) to 
perform MLE for every distribution. The Nelder-Mead method finds the parameter set that maximizes the likelihood 
function using a direct search method.  
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Interpret the Results 
Once the Distribution Fitting Analysis is complete, you should evaluate the results. RMC-BestFit provides 
goodness-of-fit measures and comparison graphs to help you evaluate the fits and select the best probability 
distribution to use in the Bayesian Estimation Analysis.  

Goodness-of-Fit Measures 
RMC-BestFit provides three goodness-of-fit measures: AIC, BIC, and RMSE. These measures indicate how well the 
distribution fits the input data, with a smaller value representing a better fit. The goodness-of-fit statistics are used for 
two purposes: 1) Model selection is the process of picking one fitted distribution over another; 2) whereas, fit 
validation is the process of determining whether a fitted distribution agrees well with the data. 

AIC and BIC are used for model selection among a finite set of models (the term model is synonymous with 
probability distribution). The model with the lowest AIC or BIC is preferred. When comparing multiple models, 
additional parameters often yield larger, optimized log-likelihood values. AIC and BIC penalize for more complex 
models, i.e., models with additional parameters. However, for BIC, the penalty is a function of the sample size, and so 
it is typically more severe than that of AIC. The formulas for AIC and BIC are shown in Equation 9 and Equation 10, 
respectively. To address potential over-fitting, RMC-BestFit implements a correction for small sample sizes for AIC.  

𝐴𝐴𝐴𝐴𝐴𝐴 = 2𝑘𝑘 − 2 ln�𝐿𝐿�� + 
2𝑘𝑘2 + 2𝑘𝑘
𝑛𝑛 − 𝑘𝑘 − 1

 Equation 9 

𝐵𝐵𝐵𝐵𝐵𝐵 = ln(𝑛𝑛) 𝑘𝑘 − 2 ln�𝐿𝐿�� Equation 10 

where 𝑘𝑘 is the number of parameters; 𝑛𝑛 is the sample size; and 𝐿𝐿� is the maximum value of the likelihood function for 
the model. 

RSME provides a measure for fit validation, with smaller values indicating a better fit. RMSE is computed based on 
how well the probability distribution agrees with the plotting positions of the input data. You can set the plotting 
position parameter based on preference or theoretical motives, so this measure has the potential to be biased. To 
minimize this issue, the default plotting position coefficient in the input data interface is set to Weibull (𝛼𝛼 = 0), which is 
unbiased. The formula for RMSE is as follows:  

𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅 =  �∑ (𝑦𝑦�𝑖𝑖 − 𝑦𝑦𝑖𝑖)2𝑛𝑛
𝑖𝑖=1

𝑛𝑛
 Equation 11 

where 𝑛𝑛 is the sample size; 𝑦𝑦�𝑖𝑖 is the predicted value for item 𝑖𝑖; and 𝑦𝑦𝑖𝑖 is the observed value for step 𝑖𝑖. 

You can sort each column of the goodness-of-fit table in ascending or descending order by right-clicking the column 
header as shown in Figure 66. As you move your cursor over the table, a tooltip will appear showing the fitted 
parameters of the distribution as shown in Figure 67. You may check or uncheck distributions in this table to add or 
remove the fitted distributions from the comparison plots.  
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Figure 66 – Distribution Fitting Analysis Goodness-of-Fit Table. 

 

 
Figure 67 – Check or Uncheck Distributions from the Goodness-of-Fit Table. 
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Comparison Plots 
RMC-BestFit provides five types of graphs to help you visually assess the quality of the distribution fits. A comparison 
graph plots the input data and fitted distributions on the same graph, allowing you to visually compare them. The 
graphs allow you to determine whether the fitted distribution matches the input data in critical areas. For example, for 
flood frequency analyses, it is important to have good agreement in the extreme, right-hand tail of the distribution.  

Frequency Plot 
A Frequency Plot is a plot of magnitude versus annual exceedance probability (AEP). AEP is typically plotted on the 
X-axis using a Normal or Gumbel probability scale to linearize the plot and exaggerate the extreme right-hand tail of 
the data. The frequency plot compares the fitted distributions to the plotting positions of the input data as shown in 
Figure 68.  

For demonstration purposes, let’s only evaluate the three-parameter distributions. Uncheck all of the two-parameter 
distributions in the goodness-of-fit table. Then sort the RMSE column in ascending order as shown in Figure 68. We 
see that the Log-Pearson Type III (LPIII) distribution provides the smallest RMSE. In addition, we can also see that it 
provides a very good fit through the input data plotted in the Frequency Plot. The Pearson Type III (PIII) and 
Generalized Extreme Value (GEV) distributions also fit through the data well and have a relatively small RSME.  

 
Figure 68 – Distribution Fitting Analysis Frequency Plot. 
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PDF Plot 
A PDF Plot compares the probability density function (PDF) of the fitted distribution to a histogram of the input data as 
shown in Figure 69. The Frequency Plot and PDF Plot are usually the most informative comparisons. With the PDF 
plot, it is easy to see the where the highest discrepancies are and whether the general shape of the data and fitted 
distributions agree well. From the PDF plot, we can see that Generalized Pareto (GPA) distribution does not fit the 
data as well as the others.  

 

 
Figure 69 – Distribution Fitting Analysis PDF Plot. 

 

 

 

 

 

 

 

 

 



 
RMC-BestFit Quick Start Guide 

 

 

  
51 

 

CDF Plot 
The CDF Plot compares the cumulative distribution function (CDF) of the fitted distribution to the plotting positions of 
the input data as shown in Figure 70. The CDF plot has a very insensitive scale, and is not very useful for comparing 
the location, spread, and shape of the distributions, for which the PDF plot is much better. In many cases, the CDF 
plot will not provide a good visual measure for the goodness-of-fit.  

 

 
Figure 70 – Distribution Fitting Analysis CDF Plot. 
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P-P Plot 
The Probability-Probability (P-P) plot graphs the F(x) of the model (distribution) versus the input data plotting 
positions. The closer the plot resembles the diagonal 1:1 line, the better the fit. The P-P Plot can be useful if you are 
interested in closely matching cumulative percentiles as it shows the differences between the middle of the fitted 
distributions and the input data. From the P-P plot, we can see that the GPA distribution has the poorest agreement 
with the data.  

 

 
Figure 71 – Distribution Fitting Analysis P-P Plot. 
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Q-Q Plot 
The Quantile-Quantile (Q-Q) plot graphs the inverse CDF of the model versus the percentile values of the input data. 
Again, the closer the plot resembles the diagonal 1:1 line, the better the fit. The Q-Q Plot can be useful if you are 
interested in closely matching cumulative percentiles as it shows the differences between the tails of the fitted 
distributions and the input data. From the Q-Q plot, we can see that the PIII, LPIII, and GEV distributions all fit the 
right-hand tail of the data really well. The Generalized Logistic (GLO) distribution has the poorest agreement with the 
right-hand tail of the data, followed by the GPA distribution as the second least favorable fit.  

 

 
Figure 72 – Distribution Fitting Analysis Q-Q Plot. 
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Tabular Results 
RMC-BestFit reports the parameters and basic statistics (mean, standard deviation, skewness, etc.) for each of the 
fitted distributions, which can also be compared to the same statistics for the input data. Quantiles for the specified 
output frequency AEPs are also provided in the Tabular Results.  

 
Figure 73 – Distribution Fitting Analysis Tabular Results. 

 

Selecting a Probability Distribution 
Finally, you need to select a probability distribution to carry forward to the Bayesian Estimation Analysis. The 
following steps can help you choose an appropriate distribution: 

• Start by reviewing the descriptions of the probability distributions found in the Appendix. Then, look at the 
variable in question. Does the data have bounds? Is it symmetric or skewed? Which distributions are 
theoretically appropriate for the data? 

• Select candidate distributions that best characterize the variable. 

• Then, use the Distribution Fitting Analysis results to select the distribution that best describes your Input 
Data. 

In the above example, we evaluated how well the three-parameter distributions fit 3-day inflow data at Blakely 
Mountain Dam. It was clear that the PIII, LPIII, and GEV distributions produced better fits than the GLO and GPA 
distributions. Flow data can span several orders in magnitude (e.g., 1,000 cfs to 1,000,000 cfs), and is typically 
skewed and cannot have negative values. If the skewness of the data is greater than the absolute value of 2 (𝐶𝐶𝑠𝑠 >
|2|), then the maximum likelihood estimation method cannot produce a solution for the PIII and LPIII distributions. 
Real-space flow data can often have skews much larger than 2. Therefore, LPIII better characterizes flow data than 
the PIII distribution (U.S. Geological Survey, 1982) (U.S. Geological Survey, 2018). As such, the PIII distribution is not 
considered appropriate for characterizing the flow data.  

When considering the statistical and graphical goodness-of-fit performance, and the appropriateness of the 
distribution, the LPIII distribution fits the Input Data the better than the GEV distribution. The LPIII distribution will now 
be carried forward to the Bayesian estimation analysis.   
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Bayesian Estimation Analysis 
RMC-BestFit performs Bayesian estimation using a Markov Chain Monte Carlo (MCMC) algorithm to estimate 
distribution parameters given the specified input data and parent distribution. The Bayesian estimation method 
produces the most likely estimate for parameters (posterior mode) and a characterization of the parameter 
uncertainty.  
To perform Bayesian Estimation with RMC-BestFit, there are four steps required: 

• Define Input Data and select the parent probability distribution. 

• Run the Bayesian Estimation Analysis.   

• Diagnose convergence. 

• Explore the results. 

Further details of these steps are discussed in the following sections.  

Create New Bayesian Analysis 
Let’s create a new Bayesian Estimation Analysis. Right-click on the Bayesian Estimation Analysis folder header 
and click Create New… as shown in Figure 61. Next, give the Bayesian analysis a name and click OK. 

 
Figure 74 – Create New Bayesian Estimation Analysis. 

 

Once, the new Bayesian Estimation Analysis is created, it will be automatically opened into the Tabbed 
Documents area, and the Bayesian analysis properties will be displayed in the Properties Window. From here, you 
can set the required inputs. 
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Bayesian Analysis Framework 
In Bayesian analysis, the values of the parent probability distribution parameters 𝜃𝜃 = �𝜃𝜃1, 𝜃𝜃2, … , 𝜃𝜃𝑝𝑝� converge to a 
distribution rather than to a single best value. The uncertainty in the parameters is represented by a prior probability 
distribution 𝑃𝑃(𝜃𝜃), which is established based on information available a priori. This prior distribution is not derived from 
the observed data 𝐷𝐷 = (𝑋𝑋1, … , 𝑋𝑋𝑛𝑛), but instead comes from other sources that can be either subjective (e.g., expert 
opinion) or objective (e.g., previous statistical analyses, or regional information). After the prior distributions and the 
observed data are specified, Bayes’ theorem (Equation 12) is used to combine the a priori information about the 
parameters with the observed data, using the likelihood 𝑃𝑃(𝐷𝐷|𝜃𝜃) (Equation 13). 

𝑃𝑃(𝜃𝜃|D) =
𝑃𝑃(𝐷𝐷|𝜃𝜃) ∙ 𝑃𝑃(𝜃𝜃)

∫ 𝑃𝑃(𝐷𝐷|𝜃𝜃) ∙ 𝑃𝑃(𝜃𝜃) ∙ 𝑑𝑑𝑑𝑑
 Equation 12 

𝑃𝑃(𝐷𝐷|θ) =  � 𝑓𝑓(𝑋𝑋𝑖𝑖|θ)
𝑛𝑛

𝑖𝑖=1

 Equation 13 

where 𝑃𝑃(𝜃𝜃|D) is the posterior probability density function (PDF) of 𝜃𝜃; 𝑃𝑃(𝜃𝜃) is the prior pdf of 𝜃𝜃; and 𝑃𝑃(𝐷𝐷|θ) is the 
likelihood function. The posterior cumulative distribution function (CDF) of 𝑋𝑋 now follows from the total probability 
theorem: 

𝐹𝐹(𝑋𝑋) =  � 𝐹𝐹(𝑋𝑋|𝜃𝜃, 𝐷𝐷) ∙ 𝑃𝑃(𝜃𝜃|𝐷𝐷) ∙ 𝑑𝑑𝑑𝑑  Equation 14 

which is a probability-weighted sum of the CDFs under different posterior parameter sets 𝜃𝜃1, 𝜃𝜃2, … , 𝜃𝜃𝑛𝑛. Equation 14 is 
known as the Bayesian posterior predictive distribution, and is equivalent to the expected probability of exceedance 
concept first presented by (Beard, 1960). Stedinger (1983) and Kuczera (1999) refer to this integral as the design 
flood distribution, and it is considered the optimal estimator of an exceedance probability.  
In most cases, there is not a closed form solution to the denominator of Equation 12. Therefore, Monte Carlo 
simulation techniques such as Markov Chain Monte Carlo (MCMC) are required. The RMC-BestFit software employs 
an adaptive Differential Evolution Markov Chain (DE-MCz) population-based sampler (ter Braak & Vrugt, 2008), which 
has proven to be very efficient at arriving at the posterior distribution. 
Figure 75 illustrates the basic steps in Bayesian analysis. The Bayesian approach offers a framework that is well 
suited to incorporate different sources of information, such as systematic records, historical data, regional information, 
and other information along with related uncertainties (Viglione, Merz, Salinas, & Bloschl, 2013). The Bayesian 
approach allows you to formally include your own expertise into the analysis by choosing a priori distributions. The 
possibility to combine this information with the observed data is even more important because, in practice, the 
observed records are usually of limited size.  

 
Figure 75 – Diagram Illustrating the Basic Steps in Bayesian Analysis (adapted from (Meylan, 2012), which was originally taken  
(Perreault, 2000)). 
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Define Inputs 
You must select the Input Data and the parent probability distribution to use in the Bayesian Estimation Analysis. 
The parent distribution describes the parent population of your Input Data, which is assumed to be a sample from the 
parent population. By default, the parent distribution is set as the Generalized Extreme Value (GEV) distribution.  

To select your data, click the Input Data drop-down on the General tab and select the desired data for the Bayesian 
analysis as shown in Figure 76. Next, set the parent distribution to be the distribution selected from the Distribution 
Fitting Analysis, which in this case was Log-Pearson Type III (LPIII). The prior distributions for parameters and 
quantiles can also be set from the General tab.  

 

 
Figure 76 – Bayesian Estimation Analysis General Properties. 
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Default Flat Priors 
After you have selected the Input Data and parent distribution, RMC-BestFit automatically develops default flat 
(uniform) priors for the selected distribution, given the data. The goal of this routine is to develop prior distributions 
that have minimal impact on the posterior distributions. This approach is sometimes referred to as vague priors, or 
weakly informative priors. Weakly informative priors contain information to keep the posterior within reasonable 
bounds without fully capturing one’s scientific knowledge about the underlying parameter (Gelman, et al., 2014). 
There are two approaches to developing a weakly informative prior as described by Gelman et al (2014): 

1. Start with some version of an uninformative prior distribution and then add enough information so that 
inferences are constrained to be reasonable.  
 

2. Start with a strong, highly informative prior and broaden it to account for uncertainty in one’s prior beliefs and 
in the applicability of any historically based prior distributions to new data.  

RMC-BestFit develops default flat priors by first considering the parent distribution and parameter support, and then 
peeking at the data to determine broad upper and lower constraints for the parameters. This ensures the prior 
distributions for parameters are somewhat centered near the likelihood, but with a much larger spread. The typical 
end-user of RMC-BestFit will likely not have much advanced training in Bayesian statistics. Therefore, the routine for 
default flat priors ensures you will get reasonable results out of the box.  

The default flat priors are shown in Figure 77. You may uncheck the Use Default Flat Priors checkbox to customize 
the priors. See the Informative Priors section for details on how to set informative priors for parameters and quantiles. 

 
Figure 77 – Default Flat Prior Distributions for Parameters.  
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Simulation Options 
For typical applications, the default simulation options should provide reasonable results out of the box. The Bayesian 
Estimation Analysis has the following simulation options (see Figure 78) available for advanced users: 

• Number of Chains: The Bayesian Estimation Analysis utilizes an adaptive Differential Evolution Markov 
Chain (DE-MCz) population-based sampler (ter Braak & Vrugt, 2008), in which multiple chains are run in 
parallel. It is recommended that the number of chains be 2 times the number of parent distribution 
parameters.  

• Thinning Interval: Determines how often the Markov Chain Monte Carlo (MCMC) evolutions will be recorded. 
Thinning can be used to reduce autocorrelation in the posterior distributions. A thinning interval of 20 means 
that every 20th iteration will be recorded.  

• Warm Up Evolutions: The number of thinned warm up MCMC evolutions to discard at the beginning of the 
simulation. It is recommended that the warm up be half the length of the number of evolutions; e.g., if the 
number of evolutions is 4,000, then the warm up length should be 2,000.  

• Evolutions: The number of thinned MCMC evolutions to simulate. If the thinning interval is 10 and the 
number of evolutions is 1,000, there will be a total of 10,000 iterations in the simulation. It is recommended to 
simulate at least 3,000 thinned evolutions. 

• PRNG Seed: The pseudo random number generator (PRNG) seed used within the Monte Carlo simulation. 
The PRNG ensures repeatability.  

• Initial Population: Determines the length of the initial population vector. It is recommended that the initial 
population be at least 100 times the number of parent distribution parameters in length. 

• Jump Parameter (𝜸𝜸): The jump parameter allows the simulation to jump from one mode region to another in 
the target distribution. It is recommended to set 𝛾𝛾 = 2.38/√2𝑑𝑑, where 𝑑𝑑 is the number of parent distribution 
parameters. 

• Jump Threshold: Determines how often the jump parameter (𝛾𝛾) switches to 1.0. It is recommended that the 
jump threshold be set to 0.20, which will result in adaptation 20% of the time.  

• Noise Parameter (𝒃𝒃): A random noise 𝜀𝜀 is added to the proposal in the MCMC simulation. The noise follows 
a uniform distribution 𝑈𝑈(−𝑏𝑏, +𝑏𝑏). It is recommended that 𝑏𝑏 be very small, such as 0.001. 

The simulation options are automatically set with default settings. You can uncheck the Use Defaults checkbox to 
customize the settings.  

Output Options 
The Bayesian Estimation Analysis has the following output options (see Figure 78): 

• Credible Interval: Sets the width of the credible interval. For a 90% credible interval, the value of interest lies 
with a 90% probability in the interval.  

• Output Length: The number of posterior parameter sets to output. It is recommended to output 10,000 
parameter sets to ensure an accurate 90% credible interval.   

• Output Frequency Ordinates: The annual exceedance probabilities (AEP) used for plotting the results on 
the frequency plot. The default frequency ordinates range from 0.99 to 1E-6 AEP. 
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Figure 78 – Bayesian Estimation Analysis Simulation and Output Options.  

 

Run the Bayesian Analysis 
After you have defined all of your inputs and settings, click the Estimate command button to run the Bayesian 
analysis. The runtime typically takes on the order of 30 seconds, depending on your computer configurations. A 
progress bar will appear to the left of the Estimate command button as shown in Figure 79. When the analysis is 
complete, you will see the frequency curve with credible intervals appear in Frequency Results plot located in the 
Tabbed Documents area. 

 
Figure 79 – Run the Bayesian Estimation Analysis. 
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Diagnose Convergence 
After you have run the Bayesian Estimation Analysis, RMC-BestFit provides several useful plots for diagnosing the 
simulation convergence. The default simulation option (see Simulation Options) will typically ensure that you get 
reasonable results. However, there may be situations where you would like to adjust the simulation options to reduce 
runtimes while still achieving accurate results.  

The Bayesian Estimation Analysis will open to the Frequency Results tab by default because this information is of 
most useful for a typical user. However, let’s start from the bottom and work upward by first clicking on the Markov 
Chain Traces tab as shown in Figure 80. 

Markov Chain Traces 
Trace plots provide an important tool for assessing the mixing of a Markov chain. The trace plot is a time series plot of 
the Markov Chain iterations. The trace plot shows the evolution of a parameter vector over the iterations of one or all 
chains. You can select the distribution parameter and which chain(s) to view. In addition, you can include the warm up 
evolutions. Let’s select the Skew (of log)(𝜸𝜸) parameter and All Chains and check the Include Warm Up checkbox, 
as shown in Figure 80. 

We can see that for the first 100 or so evolutions, the sampler is warming up and has not yet converged. After that 
point, we see that the MCMC sampler seems to be mixing well because all of the chains are exploring the same 
region of the parameter space. 

What you want to look for is any anomaly in the traces. Are there any chains significantly different from the others? Is 
there multimodality? In other words, do the traces jump from one modal region to another? These would be signs of 
poor mixing, and would indicate that you need to increase the number of evolutions.  

 
Figure 80 – Markov Chain Traces. 
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Autocorrelation 
Another way to check for convergence is to look at the autocorrelations between the MCMC samples. MCMC samples 
are dependent, so there will be correlation among each consecutive iteration. This will not affect the validity of 
inference on the posterior samples so long as the sampler has time to fully explore the posterior distribution. However, 
autocorrelation will affect the efficiency of the sampler. In other words, highly correlated chains require more samples 
to produce the same level of precision for an estimate. Since autocorrelation tends to decrease as the lag increases, 
thinning samples will reduce the final autocorrelation in the sample while also reducing the total number of saved 
MCMC iterations required. 

Select the Autocorrelation tab and select the Skew (of log)(𝜸𝜸) parameter as shown in Figure 81. This plot shows the 
lag-k autocorrelation between every sample and the sample k steps before. The autocorrelation should decrease as k 
increases. When the autocorrelation is zero, the samples can be considered independent. Conversely, if the 
autocorrelation remains high for higher values of k, then this indicates a high degree of correlation between samples 
and slow mixing.  

The Thinning Interval is set to 20 by default in the simulation options. We can see that this ensures we get good 
mixing and near zero autocorrelation.  

 
Figure 81 – Autocorrelation. 
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Mean Likelihood 
Another way to check for convergence is to see if log-likelihood function is stable. Select the Mean Likelihood tab. 
We can see that during the first 100 or so evolutions, the sampler is warming up and has not yet converged. As we 
previously saw in the Markov Chain trace plot, all of the chains are exploring the same region of the parameter space, 
which leads to a very stable mean log-likelihood.  

 
Figure 82 – Mean Likelihood. 

 

It is recommended that you do not rely on a single diagnostic measure. It is important to use a weight-of-evidence 
approach and view many different diagnostics. After examining these plots, we can be confident that the MCMC 
simulation has converged. Now let’s explore the results.  
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Explore Results 
RMC-BestFit provides several tools for exploring the results of the Bayesian analysis. The Bayesian Estimation 
Analysis will open to the Frequency Results tab by default as shown in Figure 83.  

Frequency Results 
The posterior predictive distribution, posterior mode distribution, and the credible intervals will be plotted on the 
Graphical Results tab. By default, the posterior parent distribution is plotted as a frequency curve, with annual 
exceedance probabilities plotted on the X-axis using a Normal scale, and magnitude on the Y-axis using a logarithmic 
scale. You may edit the plot properties, flip the axes, or changing the axes scales as desired. RMC-BestFit will save 
and persist all of the changes you have made to the plot.  

 
Figure 83 – Graphical Frequency Results. 

 

Click the Tabular Results tab to view the frequency curve results and the posterior mode summary statistics as 
shown in Figure 84. All of the outputted posterior parameter sets and associated log-likelihood values are available on 
the Parameter Sets tab as shown in Figure 85. You may sort these tables, and copy all of the values for external use.  
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Figure 84 – Tabular Frequency Results. 

 

 
Figure 85 – Parameter Sets. 
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Kernel Density 
RMC-BestFit provides kernel density plots of the marginal posterior distribution of parameters. Kernel density 
estimates are closely related to histograms, but provide smoothness and continuity. Select the Kernel Density tab, 
select the Skew (of log)(𝜸𝜸) parameter, and check the Show Prior Distribution checkbox, as shown in Figure 86. 
Recall that the prior for skew was set as a uniform distribution 𝑈𝑈(−2, +2).  

Underneath the plot, you can expand the Summary Statistics for the marginal distribution. Here we can see that the 
mean of the skew (of log) parameter is -0.3337 with a standard deviation of 0.1756. You will also notice that there is a 
statistic labeled Rhat. This is often referred to as the Gelman-Rubin statistic, which assesses the mixing of the 
Markov chains using the between- and within-chain variances (Gelman, et al., 2014). A Rhat equal to 1.0 indicates 
that the posterior distribution has likely converged.  

 
Figure 86 – Kernel Density. 
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Histogram 
RMC-BestFit also provides histograms of the marginal posterior distribution of parameters. These plots provide the 
same information as the kernel density plots. The histogram bins are set using the Rice rule 𝑘𝑘 = 2√𝑛𝑛3 , where 𝑘𝑘 is the 
number of bins, and 𝑛𝑛 is the number of posterior parameter sets.  

 
Figure 87 – Histogram. 
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Bivariate 
RMC-BestFit provides the option to view the marginal posterior density functions for any pair of parameters as a two-
dimensional heat map, with the color red indicating the highest density and blue indicated lowest density. Bivariate 
plots illustrate the dependence among the parent distribution parameters.  

Typically, the higher order parameters are dependent on the lower order parameters. Set the X Parameter to be the 
Std Dev (of log) (𝝈𝝈) and the Y Parameter to be Skew (of log)(𝜸𝜸), as shown in Figure 88. We can see that standard 
deviation is negatively correlated with skew. Smaller standard deviations result in higher skews; whereas higher 
standard deviations results in lower skews. This tradeoff in parameters is typical with the LPIII distribution. 

 

 

Figure 88 – Bivariate. 
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Informative Priors 
An informative prior provides specific, scientific information about the parameter. Prior information can be obtained 
from regional analysis, causal modeling, or expert elicitation. In flood frequency, an example of an informative prior 
would be the use of a regional skew (Kuczera G. , 1983) for the LPIII distribution as described in Bulletin 17B (U.S. 
Geological Survey, 1982) and 17C (U.S. Geological Survey, 2018).  

For the Blakely Mountain Dam, regional skew information was obtained from a USGS regional study of Arkansas, 
Oklahoma, and Louisiana (Wagner, Krieger, & Veilleux, 2016). From the USGS study, the regional skew was 
determined to be -0.17 with a mean-square error (MSE) of 0.12. This information can be incorporated into the 
Bayesian analysis by setting the prior for the skew parameter of LPIII to be a Normal distribution with a mean of -0.17 
and standard deviation of 0.35, or √0.12.  

First, uncheck the Use Default Flat Priors checkbox located on the General tab of the Properties Window. Then, 
click the distribution button for the skew (of log) parameter. A distribution selector will pop open to the left of the 
button, as shown in Figure 89. 

 

 Figure 89 – Informative Prior on Skew. 

 

 

 

 



 
RMC-BestFit Quick Start Guide 

 

 

  
70 

 

Next, select the Normal distribution and set the mean to be -0.17 and the standard deviation to be 0.35 as shown 
below.  

 

Figure 90 – Select Distribution for Skew. 

 

Click away from the distribution selector popup and it will automatically close. You will now see that the prior 
distribution for skew has been set as 𝑁𝑁(−0.17, 0.35). Now, click the Estimate command button to perform the 
Bayesian analysis using the informative prior. 

 

Figure 91 – Prior Distributions for Parameters. 
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When the simulation is complete, click on the Kernel Density tab and select the Skew (of log)(𝜸𝜸) parameter. When 
we used the default flat prior, the mean of the skew (of log) was -0.3337 with a standard deviation of 0.1756. Now, 
with the informative prior, we can see that the mean of the skew (of log) is -0.3062 with a standard deviation of 
0.1616. The inclusion of the regional skew information has made the skew parameter less negative and reduced the 
variance.  

As the sample size increases, the influence of the prior distribution on posterior inferences will decrease because the 
data likelihood will dominate. Taking this into account, regional prior information is most valuable when the at-site 
sample sizes are small relative to the effective sample size of the regional information.  

 

 

Figure 92 – View Results of Using an Informative Prior.  
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Priors on Quantiles 
Modeled rainfall-runoff results can be incorporated into the Bayesian analysis by defining a prior distribution for a flood 
quantile. This approach is referred to as causal information expansion, which analyzes the generating mechanisms of 
floods in the catchment of interest (Merz & Bloschl, 2008).  

A regional precipitation-frequency analysis was performed for the Blakely Mountain watershed, and 3-day basin-
average rainfall-frequency events were routed using a calibrated HEC-HMS model. The main benefit of modeling 
regional rainfall-frequency information is that available rainfall records are often much longer than the at-site flood 
records. Therefore, the regional information combined with causal rainfall-runoff modeling can provide important prior 
information on the flood quantiles.  

Use Single Quantile 
Prior distributions for flood quantiles can be set in one of two ways. First, check the Enable Priors on Quantiles 
checkbox located on the General tab of the Properties Window. By default, the Use Single Quantile checkbox will 
also be checked. For more details on this single quantile approach, please refer to (Viglione, Merz, Salinas, & Bloschl, 
2013) and (Skahill, Viglione, & Byrd, 2016). 

From the analysis performed with HEC-HMS, the distribution of rainfall-runoff at the 1E-4 AEP was determined to be 
Normally distributed with a mean of 155,000 cfs and a standard deviation of 22,000 cfs. This rare AEP was selected 
because in order to add information to the fit, it needed to be rarer than the paleoflood event, while not being so rare 
as to be overly influential.  

Click the distribution button and a distribution selector will pop open to the left of the button as shown in Figure 93. 
The Normal distribution is the only option available for priors on quantiles. Next, set the mean to be 155,000 and the 
standard deviation to be 22,000. Click away from the distribution selector popup and it will automatically close. Now, 
select the 0.0001 AEP as shown below in Figure 93.  

 

  

Figure 93 – Select Distribution for a Quantile. 
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You will now see that the prior distribution for the quantile has been set to 𝑁𝑁(155000, 22000). Now, click the 
Estimate command button to perform the Bayesian analysis using the informative quantile prior. When the analysis is 
complete, you will see the frequency curve with credible intervals appear in the Frequency Results plot located in the 
Tabbed Documents area. The mean of the quantile prior will be displayed as a green square, and the 5th and 95th 
percentiles of the prior will be shown as a vertical error bar, as shown in Figure 95. 

 

Figure 94 – Prior Distributions for a Single Quantile. 

 

 

Figure 95 – Frequency Results Using a Prior Distribution for a Single Quantile. 
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If we click on the Kernel Density tab and select the Skew (of log)(𝜸𝜸) parameter, we can see that the mean of the 
skew (of log) is -0.2384 with a standard deviation of 0.1465. The inclusion of the causal rainfall-runoff information has 
made the skew parameter significantly less negative, reduced the variance, and reduced the width of the resulting 
credible intervals of the Frequency Results.  

 

Figure 96 – Summary Statistics Results for the Skew Parameter after Using an Informative Prior on a Single Quantile. 

 

Use Multiple Quantiles 
The final way to set prior distributions for flood quantiles is to uncheck the Use Single Quantile checkbox. This option 
for setting priors on distribution quantiles follows the approach used in (Coles & Tawn, 1996). The number of quantile 
priors must be equal to the number of distribution parameters. For example, for the LPIII distribution there must be 
three quantile priors. 

In the single quantile approach shown above, the choice of AEP for the prior information has a large influence on the 
resulting fit and credible intervals. If a more frequent quantile is chosen, such as 1E-2, more weight would be given to 
the historical and paleoflood data and the quantile prior would have less influence on the fit. Whereas, the choice of 
the 1E-4 quantile gives significant weight to the prior. Choosing a rare quantile implies that we have high confidence 
in the regional precipitation-frequency analysis and modeled rainfall-runoff results. In general, the rarer the chosen 
quantile for the prior information, the more influence it will have on the posterior results. 

As a general rule of thumb, if you are using NOAA Atlas 141 (A14) precipitation-frequency data with a three parameter 
distribution, such as LPIII, then you should enter quantile priors for 1E-1, 1E-2, and 1E-3. However, if you have 
performed a custom regional precipitation-frequency analysis that is believed to be of higher quality than A14, you 
should enter priors for 1E-2, 1E-3, and 1E-4.  

In the case of Blakely Mountain Dam, a custom regional analysis was performed for the nearby Trinity River Basin in 
Texas, which is described in (MetStat, Inc., 2018). The regional frequency analysis performed for the Trinity River 
Basin also included the geographical region where the Blakely Mountain watershed is located in Arkansas. This study 
incorporated advanced techniques, such as storm typing; therefore, the results are considered to provide a better 
extrapolation to rare exceedance probabilities than A14. 

Using the results from the HEC-HMS analysis, the distribution of rainfall-runoff for the 1E-2, 1E-3, and 1E-4 AEP 
quantiles are shown in Figure 97. After you have entered these prior distributions, click the Estimate command button 
to perform the Bayesian analysis. The Frequency Results plot is shown below in Figure 98. 

 
Figure 97 – Prior Distributions for Multiple Quantiles. 

 

 
1 https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html  

https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html
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Figure 98 – Frequency Results Using a Prior Distribution for Multiple Quantiles. 

 

If we click on the Kernel Density tab and select the Skew (of log)(𝜸𝜸) parameter, we can see that the mean of the 
skew (of log) is -0.2779 with a standard deviation of 0.1500. The use of multiple quantiles has still made the skew 
parameter less negative and reduced the variance. However, the effect is less noticeable as compared to what we 
saw with the single quantile option. With this in mind, the single quantile option has a potential to underestimate the 
true parameter and quantile variance. The multiple quantile prior method provides a more complete treatment of the 
priors, and is considered a better choice when the data is available.   

 
Figure 99 – Summary Statistics Results for the Skew Parameter after Using an Informative Prior on Multiple Quantiles. 

 

As we saw in the regional skew example, when the at-site sample size increases, the influence of the prior distribution 
on posterior will decrease because the data likelihood will dominate. Taking this into account, prior information on 
quantiles is most valuable when the at-site sample sizes are small relative to the effective sample size of the regional 
precipitation-frequency and causal rainfall-runoff information. For further information on setting informative priors for 
quantiles, please see (Coles & Tawn, 1996), (Smith, 2005), (Viglione, Merz, Salinas, & Bloschl, 2013), and (Skahill, 
Viglione, & Byrd, 2016). 

You have now finished the example application with RMC-BestFit. Save the project by selecting File > Save, or by 
clicking the Save button on the main window Tool Bar.   
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Appendix – Probability Distributions 
Normal and Related Distributions 
 

Normal 
 

Description The Normal (or Gaussian) distribution is a very widely used two-parameter probability 
distribution. The Normal distribution is fundamental to most statistical modeling because 
of the Central Limit Theorem, which states that the mean of independent random 
variables trends towards a Normal distribution, even if the original variables themselves 
are not Normally distributed. The Normal distribution fits many natural phenomena, such 
as body heights, blood pressure, measurement error, and annual rainfall.  

Parameters location: 𝜇𝜇 
scale: 𝜎𝜎 
 

Support −∞ < 𝑥𝑥 < +∞  
 
−∞ < 𝜇𝜇 < +∞  
 
0 < 𝜎𝜎 < +∞  
 

Distribution 
Functions 𝑓𝑓(𝑥𝑥|𝜇𝜇, 𝜎𝜎) =  1

𝜎𝜎√2𝜋𝜋
𝑒𝑒−1

2�𝑥𝑥−𝜇𝜇
𝜎𝜎 �

2

  
 
 
𝐹𝐹(𝑥𝑥|𝜇𝜇, 𝜎𝜎) =  1

2
�1 + erf �𝑥𝑥−𝜇𝜇

𝜎𝜎√2
��  

 
 
𝐹𝐹−1(𝑝𝑝|𝜇𝜇, 𝜎𝜎) =  𝜇𝜇 + 𝜎𝜎√2 erf −1(2𝑝𝑝 − 1)  
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Log-Normal 
 

Description The log-Normal distribution is a two-parameter positively skewed distribution that 
describes a random variable whose logarithm is Normally distributed. A log-Normal 
process arises from the multiplicative product of many independent random variables, 
each of which is positive. In hydrology, the log-Normal distribution is used for frequency 
analysis of annual maximum discharge. In reliability analysis, it is often used to model 
times to repair a system.  

RMC-BestFit contains two log-Normal distributions. The first, named “Ln-Normal” is 
based on the natural logarithm, or log base 𝑒𝑒. This distribution is parameterized using 
real-space moments to be more intuitive for multi-disciplinary users of the software. The 
other distribution, named “Log-Normal” uses log base 10 and is parameterized using 
log10 moments, which is consistent with typical practice in hydrologic frequency analysis. 
Both of these log-Normal distributions are functionally identical, and will produce the 
same statistical inference.  

Parameters location: 𝜇𝜇 
scale: 𝜎𝜎 
 

Support 0 < 𝑥𝑥 < +∞  
 
−∞ < 𝜇𝜇 < +∞  
 
0 < 𝜎𝜎 < +∞  
 

Distribution 
Functions 𝑓𝑓(𝑥𝑥|𝜇𝜇, 𝜎𝜎) =  1

𝑥𝑥𝑥𝑥√2𝜋𝜋
𝑒𝑒−1

2�ln 𝑥𝑥−𝜇𝜇
𝜎𝜎 �

2

  
 
 
𝐹𝐹(𝑥𝑥|𝜇𝜇, 𝜎𝜎) =  1

2
�1 + erf �ln 𝑥𝑥−𝜇𝜇

𝜎𝜎√2
��  

 
 
𝐹𝐹−1(𝑝𝑝|𝜇𝜇, 𝜎𝜎) =  𝑒𝑒𝜇𝜇+𝜎𝜎√2 erf−1(2𝑝𝑝−1)  
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Gamma Family of Distributions 
Exponential 
 

Description The two-parameter (or shifted) Exponential distribution is a special case of the Gamma 
family of distributions, which includes the two-parameter Gamma, Pearson Type III, and 
Log-Pearson Type III. The Exponential distribution describes the time between events in 
a Poisson process; i.e., a process in which events occur continuously and independently at 
a constant average rate. The Exponential distribution is often used in reliability 
applications, where it can be used to model data with a constant failure rate. This 
distribution is useful for modeling highly positively skewed data that have a non-zero 
lower bound.  

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
 

Support 𝜉𝜉 ≤ 𝑥𝑥 < +∞  
 
−∞ < 𝜉𝜉 < +∞  
 
0 < 𝛼𝛼 < +∞  
 

Distribution 
Functions 𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼) =  𝛼𝛼−1𝑒𝑒−�𝑥𝑥−𝜉𝜉

𝛼𝛼 �  
 
 

𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼) = 1 − 𝑒𝑒−�𝑥𝑥−𝜉𝜉
𝛼𝛼 �  

 
 
𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼) =  𝜉𝜉 − 𝛼𝛼 ln(1 − 𝑝𝑝)  
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Gamma 
 

Description The Gamma distribution is a two-parameter, positively-skewed distribution. The 
Exponential, Erlang, and Chi-squared distributions are special cases of the Gamma 
distribution. There are three different parameterizations for the Gamma distribution in 
common use: 

1) With a scale parameter 𝜃𝜃 and a shape parameter 𝜅𝜅. 

2) With an inverse scale parameter 𝛽𝛽 = 1/𝜃𝜃, called a rate parameter, and a shape 
parameter 𝛼𝛼 = 𝜅𝜅. 

3) With a mean parameter 𝜇𝜇 = 𝑘𝑘𝑘𝑘 = 𝛼𝛼/𝛽𝛽 and a shape parameter 𝜅𝜅.  

RMC –BestFit uses the first parameterization, with a scale parameter 𝜃𝜃 and a shape 
parameter 𝜅𝜅. 

The Gamma distribution has applications in hydrology, econometrics, and other applied 
fields. It is a flexible distribution that is capable of modeling many kinds of data with a 
mild positive skew and lower bound of zero.  

Parameters scale: 𝜃𝜃 
shape: 𝜅𝜅 
 

Support 0 < 𝑥𝑥 < +∞  
 
0 < 𝜃𝜃 < +∞  
 
0 < 𝜅𝜅 < +∞   
 

Distribution 
Functions 

𝑓𝑓(𝑥𝑥|𝜃𝜃, 𝜅𝜅) =  1
Γ(𝜅𝜅)𝜃𝜃𝜅𝜅 𝑥𝑥𝜅𝜅−1𝑒𝑒−𝑥𝑥

𝜃𝜃  ;where Γ(∙)  is the gamma function. 
 
 
𝐹𝐹(𝑥𝑥|𝜃𝜃, 𝜅𝜅) = 1

Γ(𝜅𝜅) 𝛾𝛾 �𝜅𝜅, 𝑥𝑥
𝜃𝜃

�  ;where γ is the lower incomplete gamma function. 
 
 
𝐹𝐹−1(𝑝𝑝|𝜃𝜃, 𝜅𝜅) has no explicit analytical form. 
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Pearson Type III 
 

Description The Pearson Type III (PIII) distribution is a three-parameter distribution that is widely 
used in hydrologic frequency analysis. It has also been used to model the probability of 
wind speed and rainfall intensity. The PIII distribution is deduced from the two-
parameter gamma distribution, and converges to a Normal distribution as its skewness 
(𝛾𝛾) approaches zero.  

In RMC-BestFit, the PIII distribution is parameterized using the central moments of the 
distribution mean (𝜇𝜇), standard deviation (𝜎𝜎), and skewness (𝛾𝛾). The true parameters 
(location, scale, and shape) are computed from the specified moments. This is done 
because the moments of the distribution are more intuitively defined by end-users 
familiar with Bulletin 17B (U.S. Geological Survey, 1982) and Bulletin 17C (U.S. Geological 
Survey, 2018). RMC-BestFit uses the same parameterization as (Hosking & Wallis, 1997), 
with the underlying location parameter ξ, the scale parameter β, and the shape parameter 
α. 

Parameters mean: 𝜇𝜇 
standard deviation: 𝜎𝜎 
skewness: 𝛾𝛾 
 

location: 𝜉𝜉 = 𝜇𝜇 − 2𝜎𝜎
𝛾𝛾

 

scale: 𝛽𝛽 = 1
2

𝜎𝜎𝜎𝜎 
shape: 𝛼𝛼 = 4

𝛾𝛾2  
 

Support If 𝛾𝛾 < 0,      −∞ < 𝑥𝑥 ≤ 𝜉𝜉 
 
If 𝛾𝛾 = 0,      −∞ < 𝑥𝑥 < +∞ 
 
If 𝛾𝛾 > 0,      𝜉𝜉 ≤ 𝑥𝑥 < +∞ 
 
 

−∞ < 𝜇𝜇 < +∞  
 
0 < 𝜎𝜎 < +∞  
 
−∞ < 𝛾𝛾 < +∞  ;however, the method of 
maximum likelihood can only produce a 
solution if −2 ≤ 𝛾𝛾 ≤ +2 
 

Distribution 
Functions 

If 𝛾𝛾 < 0,      
𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑔𝑔(𝜉𝜉 − 𝑥𝑥|𝛽𝛽, 𝛼𝛼) ,      
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 1 − 𝐺𝐺(𝜉𝜉 − 𝑥𝑥|𝛽𝛽, 𝛼𝛼),    
𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝜉𝜉 − 𝐺𝐺−1(1 − 𝑝𝑝|𝛽𝛽, 𝛼𝛼)  
 
If 𝛾𝛾 = 0, then the distribution in Normal 
𝑓𝑓(𝑥𝑥|𝜇𝜇, 𝜎𝜎) = 𝑛𝑛(𝑥𝑥|𝜇𝜇, 𝜎𝜎) ,      
𝐹𝐹(𝑥𝑥|𝜇𝜇, 𝜎𝜎) = 𝑁𝑁(𝑥𝑥|𝜇𝜇, 𝜎𝜎),    
𝐹𝐹−1(𝑝𝑝|𝜇𝜇, 𝜎𝜎) = 𝑁𝑁−1(𝑝𝑝|𝜇𝜇, 𝜎𝜎)  
 
If 𝛾𝛾 > 0,   
𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑔𝑔(𝑥𝑥 − 𝜉𝜉|𝛽𝛽, 𝛼𝛼) ,      
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝐺𝐺(𝑥𝑥 − 𝜉𝜉|𝛽𝛽, 𝛼𝛼),    
𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝜉𝜉 + 𝐺𝐺−1(𝑝𝑝|𝛽𝛽, 𝛼𝛼)  

where 𝑔𝑔(∙) is the Gamma distribution 
probability density function (PDF); 𝐺𝐺(∙) is 
the Gamma cumulative distribution 
function (CDF); and 𝐺𝐺−1 is the Gamma 
inverse CDF.  
 
where 𝑛𝑛(∙) is the Normal distribution PDF; 
𝑁𝑁(∙) is the Normal CDF; and 𝑁𝑁−1 is the 
Normal inverse CDF.  
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Log-Pearson Type III 
 

Description The log-Pearson Type III (LPIII) distribution is a flexible three-parameter distribution 
that describes a random variable whose logarithm is PIII distributed. The LPIII 
distribution was originally used to model annual maximum flood flows. 

In RMC-BestFit, the LPIII uses log base 10 and is parameterizes using log10 moments of 
the distribution mean (𝜇𝜇), standard deviation (𝜎𝜎), and skewness (𝛾𝛾). The true parameters 
(location, scale, and shape) are computed from the specified moments. This is done 
because the moments of the distribution are more intuitively defined by end-users 
familiar with Bulletin 17B (U.S. Geological Survey, 1982) and Bulletin 17C (U.S. Geological 
Survey, 2018).  

Parameters mean (of log): 𝜇𝜇 
standard deviation (of log): 𝜎𝜎 
skewness (of log): 𝛾𝛾 
 

location: 𝜉𝜉 = 𝜇𝜇 − 2𝜎𝜎
𝛾𝛾

 

scale: 𝛽𝛽 = 1
2

𝜎𝜎𝜎𝜎 
shape: 𝛼𝛼 = 4

𝛾𝛾2  
 

Support If 𝛾𝛾 < 0,      0 < 𝑥𝑥 ≤ 𝜉𝜉 
 
If 𝛾𝛾 = 0,      0 < 𝑥𝑥 < +∞ 
 
If 𝛾𝛾 > 0,      𝜉𝜉 ≤ 𝑥𝑥 < +∞ 
 
 

−∞ < 𝜇𝜇 < +∞  
 
0 < 𝜎𝜎 < +∞  
 
−∞ < 𝛾𝛾 < +∞  ;however, the method of 
maximum likelihood can only produce a 
solution if −2 ≤ 𝛾𝛾 ≤ +2 
 

Distribution 
Functions 

If 𝛾𝛾 < 0,      

𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑔𝑔(log10(𝜉𝜉 − 𝑥𝑥) |𝛽𝛽, 𝛼𝛼) �𝐾𝐾
𝑥𝑥

� ,      

𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 1 − 𝐺𝐺(log10(𝜉𝜉 − 𝑥𝑥) |𝛽𝛽, 𝛼𝛼),    

𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑒𝑒�𝜉𝜉−𝐺𝐺−1(1−𝑝𝑝|𝛽𝛽,𝛼𝛼)� 𝐾𝐾⁄   
 
If 𝛾𝛾 = 0, then the distribution in Normal 

𝑓𝑓(𝑥𝑥|𝜇𝜇, 𝜎𝜎) = 𝑛𝑛(log10(𝑥𝑥) |𝜇𝜇, 𝜎𝜎) �𝐾𝐾
𝑥𝑥

� ,      

𝐹𝐹(𝑥𝑥|𝜇𝜇, 𝜎𝜎) = 𝑁𝑁(log10(𝑥𝑥) |𝜇𝜇, 𝜎𝜎),    

𝐹𝐹−1(𝑝𝑝|𝜇𝜇, 𝜎𝜎) = 𝑒𝑒�𝑁𝑁−1(𝑝𝑝|𝜇𝜇,𝜎𝜎)� 𝐾𝐾⁄   
 
If 𝛾𝛾 > 0,   

𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑔𝑔(log10(𝑥𝑥 − 𝜉𝜉) |𝛽𝛽, 𝛼𝛼) �𝐾𝐾
𝑥𝑥

� ,      

𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝐺𝐺(log10(𝑥𝑥 − 𝜉𝜉) |𝛽𝛽, 𝛼𝛼),    

𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛽𝛽, 𝛼𝛼) = 𝑒𝑒�𝜉𝜉+𝐺𝐺−1(𝑝𝑝|𝛽𝛽,𝛼𝛼)� 𝐾𝐾⁄   

where 𝑔𝑔(∙) is the Gamma distribution 
probability density function (PDF); 𝐺𝐺(∙) is 
the Gamma cumulative distribution 
function (CDF); 𝐺𝐺−1 is the Gamma inverse 
CDF; and 𝐾𝐾 = log10 𝑒𝑒.  
 
 
where 𝑛𝑛(∙) is the Normal distribution PDF; 
𝑁𝑁(∙) is the Normal CDF; and 𝑁𝑁−1 is the 
Normal inverse CDF.  
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Extreme Value Distributions 
Gumbel (Extreme Value Type I) 
 

Description The Gumbel, or Extreme Value Type-I (EVI) distribution, is a two-parameter distribution 
with a fixed positive skewness of ≈ 1.14. The Gumbel distribution is used to describe the 
maximum (or minimum) of a number of samples, and has seen widespread use in 
hydrologic frequency analysis. The Gumbel distribution is a particular case of the 
Generalized Extreme Value (GEV) distribution when the GEV shape parameter is zero. 
The Gumbel distribution is also used for a probability plotting scale because it 
exaggerates the extreme tails of the data. 

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
 

Support −∞ < 𝑥𝑥 < +∞  
 
−∞ < 𝜉𝜉 < +∞  
 
0 < 𝛼𝛼 < +∞  
 

Distribution 
Functions 

𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼) =  1
𝛼𝛼

𝑒𝑒−(𝑧𝑧+𝑒𝑒−𝑧𝑧) ;where 𝑧𝑧 =  𝑥𝑥−𝜉𝜉
𝛼𝛼

 
 
 
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼) = 𝑒𝑒−𝑒𝑒−𝑧𝑧  
 
 
𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼) =  𝜉𝜉 − 𝛼𝛼 ln(− ln(𝑝𝑝))   
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Weibull 
 

Description The Weibull distribution is a two-parameter distribution commonly used in reliability 
analysis. It is related to a number of other probability distributions. In particular, the 
Weibull distribution interpolates between the exponential distribution (for 𝜅𝜅 = 1) and 
the Rayleigh distribution (when 𝜅𝜅 = 2). If the quantity 𝑥𝑥 is the “time to failure”, the 
Weibull distribution gives the distribution for which the failure rate is proportional to a 
power of time. 

Parameters scale: 𝜆𝜆 
shape: 𝜅𝜅  
 

Support 0 ≤ 𝑥𝑥 < +∞  
 
0 < 𝜆𝜆 < +∞  
 
0 < 𝜅𝜅 < +∞  
 

Distribution 
Functions 𝑓𝑓(𝑥𝑥|𝜆𝜆, 𝜅𝜅) =  𝜅𝜅

𝜆𝜆
�𝑥𝑥

𝜆𝜆
�

𝜅𝜅−1
𝑒𝑒−𝑥𝑥

𝜆𝜆
𝜅𝜅

  
 
 

𝐹𝐹(𝑥𝑥|𝜆𝜆, 𝜅𝜅) = 1 − 𝑒𝑒−𝑥𝑥
𝜆𝜆

𝜅𝜅

  
 
 

𝐹𝐹−1(𝑝𝑝|𝜆𝜆, 𝜅𝜅) =  𝜆𝜆 ln � 1
1−𝑝𝑝

�
1
𝜅𝜅   
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Generalized Extreme Value 
 
Description The Generalized Extreme Value (GEV) distribution is a three-parameter distribution that 

subsumes the three extreme-value distributions: Gumbel (EVI), Fréchet (EVII), and 
Weibull (EVIII). The shape parameter 𝜅𝜅 determines which sub-distribution the GEV 
represents. The extreme value theorem states that the GEV distribution is the limit 
distribution of maxima of a sequence of independent and identically distributed random 
values. GEV is used for hydrologic frequency analysis, insurance, and financial risks. 

RMC-BestFit uses the Hosking’s parameterization (Hosking & Wallis, 1997), in which a 
negative shape parameter 𝜅𝜅 has no upper bound, and a positive 𝜅𝜅 has a fixed upper 
bound. Other sources adopt the opposite convention, where a negative 𝜅𝜅 implies an upper 
bound.  

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
shape: 𝜅𝜅  
 

Support If 𝜅𝜅 < 0,       𝜉𝜉 + 𝛼𝛼 𝜅𝜅⁄ ≤ 𝑥𝑥 < +∞ 
 
If 𝜅𝜅 = 0,      −∞ < 𝑥𝑥 < +∞ 
 
If 𝜅𝜅 > 0,      −∞ < 𝑥𝑥 ≤ 𝜉𝜉 + 𝛼𝛼 𝜅𝜅⁄  
 

−∞ < 𝜉𝜉 < +∞  
 
0 < 𝛼𝛼 < +∞  
 
−∞ < 𝜅𝜅 < +∞  
 

Distribution 
Functions 

⎩
⎪
⎨

⎪
⎧ 𝑧𝑧 = −

1
𝜅𝜅

ln �1 − 𝜅𝜅 �
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
��      𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝑧𝑧 =
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
                                       𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.

 

 
 
𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) =  1

𝛼𝛼
𝑒𝑒−(1−𝜅𝜅)𝑧𝑧−𝑒𝑒−𝑧𝑧  

 
 
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) = 𝑒𝑒−𝑒𝑒−𝑧𝑧   
 
 

 𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) = �
 𝜉𝜉 −

𝛼𝛼
𝜅𝜅

(1 − (− ln(𝑝𝑝))𝜅𝜅)     𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝜉𝜉 − 𝛼𝛼 ln(− ln(𝑝𝑝))               𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.
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Generalized Pareto 
 

Description The Generalized Pareto (GPA) distribution is a three-parameter distribution with a fixed 
lower bound. The GPA is upper bounded when the shape parameter is positive. When κ is 
zero, the distribution reduces to a shifted Exponential distribution. The GPA distribution 
is most often used with peaks-over-threshold data. Hydrologic frequency analysis uses 
the GPA in cases where rainfall or flow maxima exceed a specified threshold.   

RMC-BestFit uses the Hosking’s parameterization (Hosking & Wallis, 1997), in which a 
negative shape parameter 𝜅𝜅 has no upper bound, and a positive 𝜅𝜅 has a fixed upper 
bound. 

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
shape: 𝜅𝜅  
 

Support If 𝜅𝜅 ≤ 0,       𝜉𝜉 ≤ 𝑥𝑥 < +∞ 
 
If 𝜅𝜅 > 0,       𝜉𝜉 ≤ 𝑥𝑥 ≤ 𝜉𝜉 + 𝛼𝛼 𝜅𝜅⁄  
 

−∞ < 𝜉𝜉 ≤ 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑜𝑜𝑜𝑜 𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑  
 
0 < 𝛼𝛼 < +∞  
 
−∞ < 𝜅𝜅 < +∞  
 

Distribution 
Functions 

⎩
⎪
⎨

⎪
⎧ 𝑧𝑧 = −

1
𝜅𝜅

ln �1 − 𝜅𝜅 �
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
��      𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝑧𝑧 =
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
                                       𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.

 

 
 
𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) =  1

𝛼𝛼
𝑒𝑒−(1−𝜅𝜅)𝑧𝑧  

 
 
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) = 1 − 𝑒𝑒−𝑧𝑧  
 
 

 𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) = �
 𝜉𝜉 −

𝛼𝛼
𝜅𝜅

(1 − (1 − 𝑝𝑝)𝜅𝜅)     𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝜉𝜉 − 𝛼𝛼 ln(1 − 𝑝𝑝)               𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.
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Logistic Distributions 
Logistic 
 

Description The Logistic distribution is a two-parameter, symmetric distribution with heavier tails 
(higher kurtosis) than the Normal distribution. The Logistic distribution has applications 
in hydrology for long duration discharge or rainfall, such as monthly or yearly totals. The 
most common application is in logistic regression where the errors follow a Logistic 
distribution.  

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
 

Support −∞ < 𝑥𝑥 < +∞  
 
−∞ < 𝜉𝜉 < +∞  
 
0 < 𝛼𝛼 < +∞  
 

Distribution 
Functions 

𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼) =  1
𝛼𝛼

𝑒𝑒−𝑧𝑧(1 + 𝑒𝑒−𝑧𝑧)−2 ;where 𝑧𝑧 =  𝑥𝑥−𝜉𝜉
𝛼𝛼

 
 
 
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼) = (1 + 𝑒𝑒−𝑧𝑧)−1  
 
 
𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼) =  𝜉𝜉 + 𝛼𝛼 ln( 𝑝𝑝

1−𝑝𝑝
))   
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Generalized Logistic 
 

Description The Generalized Logistic (GLO) distribution is a heavy-tailed, three-parameter 
distribution. The GLO distribution has been used to fit values of extremes, such as stock 
return fluctuations and sea levels. It has been used extensively for modeling annual 
rainfall maxima, and for flood frequency analysis.  

RMC-BestFit uses the Hosking’s parameterization (Hosking & Wallis, 1997), in which a 
negative shape parameter 𝜅𝜅 has no upper bound, and a positive 𝜅𝜅 has a fixed upper 
bound. 

Parameters location: 𝜉𝜉 
scale: 𝛼𝛼  
shape: 𝜅𝜅  
 

Support If 𝜅𝜅 < 0,       𝜉𝜉 + 𝛼𝛼 𝜅𝜅⁄ ≤ 𝑥𝑥 < +∞ 
 
If 𝜅𝜅 = 0,      −∞ < 𝑥𝑥 < +∞ 
 
If 𝜅𝜅 > 0,      −∞ < 𝑥𝑥 ≤ 𝜉𝜉 + 𝛼𝛼 𝜅𝜅⁄  
 

−∞ < 𝜉𝜉 < +∞  
 
0 < 𝛼𝛼 < +∞  
 
−∞ < 𝜅𝜅 < +∞  
 

Distribution 
Functions 

⎩
⎪
⎨

⎪
⎧ 𝑧𝑧 = −

1
𝜅𝜅

ln �1 − 𝜅𝜅 �
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
��      𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝑧𝑧 =
𝑥𝑥 − 𝜉𝜉

𝛼𝛼
                                       𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.

 

 
 
𝑓𝑓(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) =  1

𝛼𝛼
𝑒𝑒−(1−𝜅𝜅)𝑧𝑧(1 + 𝑒𝑒−𝑧𝑧)−2  

 
 
𝐹𝐹(𝑥𝑥|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) = (1 + 𝑒𝑒−𝑧𝑧)−1  
 
 

 𝐹𝐹−1(𝑝𝑝|𝜉𝜉, 𝛼𝛼, 𝜅𝜅) =

⎩
⎪
⎨

⎪
⎧ 𝜉𝜉 −

𝛼𝛼
𝜅𝜅 �1 − �

1 − 𝑝𝑝
𝑝𝑝

�
𝜅𝜅

�      𝑖𝑖𝑖𝑖 𝜅𝜅 ≠ 0,

𝜉𝜉 − 𝛼𝛼 ln(
1 − 𝑝𝑝

𝑝𝑝
))                𝑖𝑖𝑖𝑖 𝜅𝜅 = 0.
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